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1. Wireless Sensor Network Overview

The LORD MicroStrain ® Wireless Sensor Network is a high- speed, scalable, sensor data
acquisition and sensor networking system.  Each system consists of wireless sensor interface
nodes, a data collection gateway, and full-featured user software platforms based on the LORD
MicroStrain® Lossless Extended Range Synchronized (LXRS®) data communications protocol. 
Bidirectional wireless communication between the node and gateway enables sensor data
collection and configuration from up to two kilometers away. Gateways can be connected locally to
a host computer or remotely via local and mobile networks. Some gateways also feature analog
outputs for porting sensor data directly to standalone data acquisition equipment.

The selection of available nodes allows interface with many types of sensors, including
accelerometers, strain gauges, pressure transducers, load cells, torque and vibration sensors,
magnetometers, 4 to 20mA sensors, thermocouples, RTD sensors, soil moisture and humidity
sensors, inclinometers, and orientation and displacement sensors. Some nodes come with
integrated sensing devices such as accelerometers. System sampling capabilities are IEEE
802.15.4-compliant and include lossless synchronized sampling, continuous and periodic burst
sampling, and data logging. A single gateway can coordinatemany nodes of any type, andmultiple
gateways can be managed from one computer with the Node Commander® and SensorCloud™
software platforms. Integration to customer systems can be accomplished using OEM versions of
the sensor nodes and leveraging the LORD MicroStrain® data communications protocol.

Common wireless applications of LORD MicroStrain® Sensing Systems are strain sensor
measurement, accelerometer platforms, vibration monitoring, energy monitoring, environmental
monitoring, and temperaturemonitoring.
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2. Gateway Overview

TheWSDA®-1500-LXRS®Wireless Sensor Data Aggregator is a network gateway designed to
configure, co-ordinate, and collect sensor data from LORD MicroStrain® wireless sensor nodes.
TheWSDA®-1500-LXRS® is Ethernet-capable and can be configured to operate with a static IP,
a DHCP-enabled LAN, or as a datalogger to local memory. Secure, web-based data access and
analysis is available with integration to the SensorCloud™ platform.

TheWSDA®-1500-LXRS® is also capable of pushing sensor data onto a J1939-compatible CAN
bus either by sending all of the sensor messages to one CAN address or by broadcasting user-
selectedmessages onto the CAN bus.

Figure 1 -WSDA®-1500-LXRS®Wireless Sensor Data Aggregator
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2.1 Gateway Components

The WSDA®-1500-LXRS® can be purchased individually or in a starter kit. The starter kit
includes everything required to operate the WSDA® -1500-LXRS® including a removable
external antenna, a power supply, and cables for interfacing with the host computer or network.
For a complete list of available configurations, accessories, additional system products, and
ordering information see Parts and Configurations on page 96.

Item Description Quantity
A WSDA®-1500-LXRS®Wireless Sensor Data Aggregator 1

B Antenna 1

C Ethernet cable, 10 ft 1

D Power supply and plug adapter kit 1

-- NodeCommander® Software Suite, User Manual, Quick Start
Guide, andWSDA® AccessCertificate

1

Table 1 - Starter Kit Components
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2.2 Gateway Interface

The WSDA®-1500-LXRS® interfaces include a power input jack , a power on/off switch, an
antenna connector for attaching the gateway antenna, an Ethernet jack, amulti-use (multi-port)
connector, and a USB port reserved for future use.

The indicators on the WSDA® - 1500- LXRS® include a several device and data status
indicators, and a power indicator. The following table describes basic indicator behavior. For a
complete list of all indicator behaviors see Device Status Indicators on page 91.

Figure 2 - Ports and Indicators

Indicator Behavior Node Status

POWER
OFF Gateway is off
ON green Gateway is on

CLOUD
Flashing blue Uploading data to SensorCloud™
ON green Web upload successful
ON red Web upload error

DATA
Flashing green Receiving wireless data
Flashing blue Sync sampling beacon enabled

WSDA
ON green Fully booted & idle

Flashing blue & green
Sampling and porting data through
Node Commander®

Table 2 - Basic Indicator Behaviors
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3. System Operational Overview

The gateway is the interface between LORD MicroStrain® sensor nodes and the data acquisition
computer or network. The gateway co-ordinates the configuration and sampling of the nodes and
can handle many nodes simultaneously. Communication between the nodes and gateway is
wireless and uses the LORD MicroStrain®LXRS® data communications protocol. LXRS® nodes,
andmany legacy nodes, will communicate with any LXRS® gateway.

Communication protocols between the gateway and host computer vary depending on which
model gateway is used. Ethernet gateways have an embedded operating system and utilize a web
based interface for device configuration.

LORD MicroStrain® has two software programs available for data acquisition from the wireless
sensor network: SensorCloud™ and Node Commander®.  SensorCloud™ is an optional web-
based data collection, visualization, analysis, and remote management platform based on cloud
computing technology. Node Commander® is used for configuring gateways and nodes, selecting
samplingmodes and parameters, initializing data acquisition, and viewing and saving data.

The operational overview describes system hardware and software setup, and the basic
navigation of Node Commander® used to configure the node and begin data acquisition.  A brief
overview of porting data to SensorCloud™ is also included. This section is included as a quick start
guide and is not a complete demonstration of all system and software capabilities.

3.1 Software Installation

To install Node Commander ® Software Suite  on the host computer, run the installer
executable file and follow the on-screen prompts. The software is provided with all gateways
and is available on the LORD MicroStrain®website (see References on page 106).

The suite includes the following programs:

l Node Commander is used for configuring nodes and acquiring, viewing, and
saving data. 

l Live Connect™ is a TCP/IP-to-serial conversion tool that translates the
communications between Node Commander and an Ethernet gateway.

l WSDA® Data Downloader is used to download acquired data from the flash
memory card embedded in an applicable gateway, to a host computer.
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SensorCloud™ is an optional data collection, visualization, analysis, and remote
management tool. It is based on cloud computing technology and is accessed directly from a
web connection. For more information see Data Handling on page 30.

Users can also design custom programs with the open source data communications
protocol (see References on page 106).

3.2 System Connections

To acquire sensor data the following components are needed: a LORD MicroStrain® data
gateway and a local or networked host computer with access to the data acquisition software
(such asNode Commander® and SensorCloud™). For a connections overview refer to Figure
3 - SystemConnections .

The sensor, node, gateway, and software selection are application-dependent, but the basic
interfaces are the same. For a connections overview using the WSDA®-1500-LXRS® refer to
Figure 3 - SystemConnections .

Users can also write custom programs by utilizing the LORD MicroStrain®Wireless Sensors
Network Software Development Kit

Figure 3 - System Connections
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3.3 Gateway Operation

NOTE

The default configuration of Ethernet gateways is for DHCP network
connectivity. In order to change the gateway communication settings, initial
connection to a DHCP-enabled network is required.

The Ethernet gateway has three primary operating sequences:

a. Gateway configuration in the internal gateway operating systemControl Panel
(accessible through Live Connect™ and any non-deprecated web browser, or dir-
ectly through the browser)

b. Node configuration and data acquisition through Node Commander®

(accessible through Live Connect™ )

c. Data acquisition, viewing, and analysis through SensorCloud™
(accessible through a live web connection)

3.3.1 Gateway Configuration

The WSDA® - 1500-LXRS® configuration Control Panel can be accessed using Live
Connect™ or directly through a web browser.

To connect directly to the gateway Control Panel through a web browser, type the device's
IP address into the browser address bar and press enter (Figure 4 - GatewayControl Panel
Access (Browser)).

Figure 4 - Gateway Control Panel Access (Browser)
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To connect to the gateway Control Panel through Live Connect™, an initial connection to a
DHCP enabled network is required.

1. Connect the host computer and gateway to the DHCP network, and apply power to
the gateway. Verify the gateway status indicator shows that it is on and has
completed the boot up process (seeGateway Interface on page 10).

2. Open Live Connect™. The gatewaywill be detected automatically but, depending on
the network, it may take two to threeminutes. Once detected, the gatewaywill appear
on the list of discovered devices and can be identified by its name or serial number
(with aWSDA® prefix) in the Device Name column (Figure 5 - Live Connect™
Interface).

Figure 5 - Live Connect™ Interface

3. To access Control Panel through Live Connect™, highlight the device, and select
the View button (Figure 6 - GatewayControl Panel Access (Live Connect™ )).

Figure 6 - Gateway Control Panel Access (Live Connect™ )
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3.3.2 Gateway Control Panel

Log in to the gatewayControl Panel with the default credentials:
a. Login: wsda
b. Password: wsda

Figure 7 - Log-in to Control Panel

The default Control Panel page after log-in is the About page. This page provides general
information about the device including serial number, network connection type, and system
information, such as system time.

Figure 8 - Control Panel Main Menu
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There is a navigation panel on the left that contains three menu categories; General, Data,
and Tools (Figure 9 - Control Panel Menus).

Figure 9 - Control Panel Menus

a. General - This category includesmenu selections for information about the gate-
way's identity and time settings (About) and the sensor nodes it currently has data
for in memory (Node List).

b. Data - This category includesmenu selections that allow users to set which node
and channel data is uploaded to SensorCloud™ (Upload Filter), set which data is
pushed out the CAN J1939 port (J1939), apply calibration coefficients to data down-
loaded from the gateway internal memory (Calibration), and clear data from the
device internal memory (Clear Data).

c. Tools - This category includesmenu selections for troubleshooting the gateway
(Diagnostics); configuring communication settings, enabling and disabling operating
sequences, changing the node synchronization beacon state, and changing the
gateway radio frequency (Configuration); configuring system time (TimeOptions);
rebooting the gateway (Reboot); updating the operating system (OS Upgrade); and
changing the Control Panel log-in (Change Password).
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3.4 Connecting to Node Commander®

Node configuration is done in Node Commander®. The following steps provide an overview
of how to access the sensor node configuration menus in Node Commander® through the
gateway Live Connect™ interface. In these menus node sensing channels are configured
and enabled, sampling modes are selected, and data acquisition can be initiated. There are
many options for node configuration including setting the node to sample continuously,
sample periodically, and to start sampling on power up. This section provides an overview
on how to access the nodemenus and adjust basic settings. Refer to the node and the Node
Commander® user manuals for additional information (see References on page 106).

Configuration of the sensor nodes in Node Commander® is done through the gateway and
the Live Connect™ interface, andmust be done initially on a DHCP enabled network.

1. Connect the host computer and gateway to the DHCP network, and apply power to
the gateway. Verify the gateway status indicator shows that it is on and has
completed the boot-up process (seeGateway Interface on page 10).

2. Open the Live Connect™ program. The gateway will be detected automatically but
depending on the network, it may take 2 to 3 minutes. Once detected, the gateway
will appear on the list of discovered devices and can be identified by its name or serial
number (with a WSDA prefix) in the Device Name column ( Figure 10 - Live
Connect™ Interface).

Figure 10 - Live Connect™ Interface
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3. Highlight the device in Live Connect™, and select the Connect button (Figure 11 -
Connecting the Gateway to Node Commander®). This will enable access to the
Node Commander® software.

Figure 11 - Connecting the Gateway to Node Commander®

4. Once connected, a virtual serial port is assigned to the gateway and will appear in the
Port column (Figure 12 - Virtual Serial Port).

Figure 12 - Virtual Serial Port
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5. Open Node Commander®.

6. The gateway will appear automatically in the Controller window with a
communication port assignment.

Figure 13 - Ethernet Gateway Communication
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3.5 Connect to Nodes

Several methods can be used in Node Commander® to establish communication with the
nodes. This quick start section covers the two simplest methods; adding a node by address and
by using the node discovery feature.

3.5.1 Adding a Node by Address

Adding a node by address requires the node to be on the same communication frequency
as the gateway. The node address and frequency are indicated in the documentation
included with the node when it is purchased.

1. To add a node by address, right-click on the gateway name in the Controller window,
and select Add Node > Add Single Node (Figure 14 - Adding a Node by Address).

2. The node address and frequency are indicated in the documentation included with
the node. Enter the node address, and select OK. If the node is not found, amessage
will appear and provide the option to scan for the node on other frequencies.
Alternately, the Node Discovery feature can be used.

Figure 14 - Adding a Node by Address
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3.5.2 Using Node Discovery

The Node Discovery feature allows connection between the gateway and node to occur
even if they are on different frequencies. To connect to all available nodes using node
discovery, begin bymaking sure the node is powered off.

NOTE

Automatic node discoverymay not work in some boot-up modes. If the node is
not in normal boot upmode, the assigned one can be bypassed to enable node
discovery. For more information see Troubleshooting Guide on page 86.

1. Right-click on the gateway name and select Add Node > NodeDiscovery (Figure 15 -
Using Node Discovery).

2. Using the power switch, turn on the node. Within a few seconds, the node will
transmit a message with its operating frequency.

3. When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one-second intervals, the node has completed the normal boot-up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window; scanning can be stopped by selecting the Stop button in the Node
Discovery window.

Figure 15 - Using Node Discovery
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3.6 Channel Configuration

The sensor settings are stored in the node memory, and each sensor is assigned a
corresponding channel number. The configuration menus will only show the channels and
configuration options that are available for the type of node being used.

1. To enter the configurationmenu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the node.

a. Channel Enabled: indicates the sensor channel number. The check box
is used to enable the channel and select it for sampling. The icon next to
the check box describes the channel type inherent to the node being used.
In the following example (Figure 16 - Node Channels Menu): a1) analog
differential channel icon, a2) analog single ended channel icon, and a3)
temperature channel icon.

b. Current channel configuration: The Data Output, Units, Input Range,
and Label fields describe how the channel is currently configured.

c. Configure: TheConfigure button changes the channel parameters, such
as measurement units, gain and offset settings, and calibration
values. The channel must be enabled first by selecting the adjacent check
box.

Figure 16 - Node Channels Menu
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2. To enter the channel configuration menu, select the Configure button as shown in
Figure 16 - Node Channels Menu . The menu options available on the channel
configuration page varies depending on the node and sensor type selected. This is an
example with a V-Link® -LXRS®.

a. Channel Label: names the channel

b. Channel diagram: shows channel electronics and data flow

c. Conversion Coefficients: defines the type and units of the
measurement beingmade

d. PGA Settings: These settings determine what gain is applied to the
sensor measurement and set the position of the no- load baseline
measurement for the sensor signal. It is only available for differential input
channels with gain amplifiers.

e. Calibration values: includes the slope, offset, scale, and formula used to
convert the sensor reading to engineering units. The slope and offset can
be determined from the sensor manufacturer calibration data or through a
calibration process.

Figure 17 - Channel Setup
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3.7 Sampling Settings

Sampling settings are accessed through the Configure Node menu. There is a tab for each
sampling mode available for the particular node ( Figure 18 - Sample Settings
Menu).Depending on the type of node, up to four samplingmodes are available: Synchronized
Sampling, Low Duty Cycle, Streaming, and Datalogging. Some modes have user-configurable
settings for sample rate, sample duration, and datalogging . Other settings are automatic,
depending on number of active channels and other variables. For more information on
samplingmodes, refer to the Node Commander user manual (see References on page 106).

Figure 18 - Sample Settings Menu

In general, when determining what sample mode and rate is most suitable for the application,
refer to the following guidelines;

l Use a sample rate at least twice the value of the target measurement frequency. This is the
minimum sample rate required to produce an accurate digital representation of the
measured signal. The higher the sample rate, themore accurate the digital representation.

l Using the minimum required sample rate will increase battery life and minimize the
allocated network bandwidth.

l Using periodic burst sampling in place of continuous sampling will increase battery life, and
the longer the sample interval, themore power and network bandwidth will be saved.

For synchronized sampling, use the online calculator to evaluate network bandwidth at different
sampling settings :

http://www.microstrain.com/configure-your-system

http://www.microstrain.com/configure-your-system
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3.8 Data Acquisition

When data acquisition is started, each of the sampling modes has different menu options and
views. Some open a settings menu before data acquisition begins and may include a data list
view and/or a graph view. The following is an example of Synchronized Sampling (Figure 19 -
Starting a Sampling Session).

To start a sampling session, nodes can be selected individually or as a group. When selected
as a group, they will all be set to the same sampling mode. Right-click on the nodes and select
Sample > Synchronized Sampling.

Figure 19 - Starting a Sampling Session

When a synchronized sampling session is started, the sampling menu appears and includes
settings to enable optional sampling features, configure nodes, and to specify where the data
will be saved. The built-in bandwidth calculator displays the total bandwidth used by the nodes
selected for synchronized sampling (Figure 20 - Synchronized SamplingMenu).

a. Save Location: indicates where the data file will be saved on the host computer.
Use the Browse button to select a location.

b. Node configuration: includes the node serial number, sampling settings,
bandwidth calculation, and current status. Highlight any node or group of nodes,
and the Remove, Configure, and Refresh buttons become active. The Configure
button opens the node configuration menus to adjust settings as needed and
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recalculates the node bandwidth. Multiple nodes can be configured together by
using the Shift or Ctrl key to select them.

c. Lossless: enables the lossless data protocol. The protocol enables buffering and
retransmission of data in order to provide 100% data collection success. Using this
featuremay increase data display latency.

Figure 20 - Synchronized Sampling Menu

d. High Capacity: optimizes bandwidth and power use for nodeswith slower sample
rates by reducing the transmit rates. May increase data latency.

e. Network Bandwidth: is the total calculated bandwidth used by all the nodes. The
bandwidth changes as nodes are added, removed. and settings changed.

f. Enable Beacon on Start:When synchronized sampling is started the nodes wait
for the first beacon transmission to initiate sampling. When this option is selected
(default), the gateway beacon is enabled and will begin transmitting at a fixed
interval when sampling is started. Disabling the beacon on start (unchecking the
box) will set the nodes to wait for the beacon, but it does not actually start the
beacon when sampling is started. This can be used if there is a need for sampling to
be initiated later, or if the beacon is being received from another source than the
gateway. Enabling the beacon in this way is the same as enabling the beacon in the
gatewaymenu For more information see Using the Beacon on page 77.

g. Apply settings and start sampling: Before acquisition can begin, use the Apply
Network Settings to save the session settings to the node. When completed, select
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Start Sampling to begin.

h. Close sampling window (with the red "X") to exit sampling or, once the sampling
has been started, to view the data window behind it.

Synchronized sampling features two data views: Grid view and Graph view. Once sampling
has started, the data grid view is the default view (Figure 21 - Synchronized Sampling Data
View).

Figure 21 - Synchronized Sampling Data View

a. Device status: Node sampling mode and gateway status are displayed in
parentheses next to the device name.

b. Node information: includes node serial number and sampling statistics. Right-
click on the node name for moremenu options such as Stop Nodes.

c. Data: is a display of the sampled data with each channel in its own column.

d. Radio strength: indicates the strength of the communication between the gateway
and node.SeeRange Test on page 83.

e. Data file: the location and size of the data file, as data is added. View the data in
.CSV format with the Open File button.

f. View menu: Select between Data Grid andGraph views.

g. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.
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NOTE

When synchronized sampling is set to slower sample rates it may take several
seconds after sampling is initiated for the first sample to appear.

Use the view menu to select the Graph view of the data (see Synchronized Sampling Graph
View on page 28). Click on the node name to view the graph for that node. Click again to hide it.

Figure 22 - Synchronized Sampling Graph View

a. Available Nodes: Click on the node to display the graph for that node. Click again
to hide it. Right-click on the node name for more menu options such as Stop Nodes
and Save Stream.

b. Axis range: Select the x-axis width and y-axis zoom percentage, or use the Auto
check box for automatic scaling.

c. Graph: The node graph shows the sampled data. Each active channel is displayed
in a different color. The x-axis is time in seconds and the y-axis is the A/D value
(bits). Right-click on the graph for additional menu options such as View Graph Key,
Pan, Zoom, Pause, and RemoveGraph.

d. View menu: Select between Data Grid andGraph views.
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e. Data file: The location and size of the data file as data is added. View the data in
.CSV format with the Open File button.

f. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.

NOTE

Once sampling has started it will continue as configured without the need to leave
Node Commander® open. However, if the node is powered off and is not configured
to sample on boot- up, data acquisition will end and must be restarted in Node
Commander®.
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3.9 Data Handling

Data acquired through Node Commander® is automatically saved on the host computer (see
Sensor Data Files on page 34) and can also be viewed from the web-based SensorCloud™
portal. Saved data can be uploaded to SensorCloud™ and Ethernet gateways provide the
option to automatically port the data to SensorCloud™ during data acquisition for near real-
time display and aggregation. Ethernet gateways can also be configured to save data locally to
internal memory for future upload to the host computer or SensorCloud™.

SensorCloud™ is based on cloud computing technology and is designed for long term
collecting and preservation of data. Features include time series and visualization graphing,
automated alerts, and data interpretation tools such as data filtering, statistical analysis, and
advanced algorithm development with the integrated MathEngine® interface. Leveraging the
open source API, SensorCloud™ can also be used to collect data from other LORD
MicroStrain® sensor products or third- party systems. Basic SensorCloud™ services are
available to all users free of charge (see Connecting to SensorCloud™ on page 31).

Figure 23 - Data Storage, Display and Processing
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3.9.1 Connecting to SensorCloud™

To connect to SensorCloud go to the SensorCloud website log-in page, and enter the log-in
credentials. Register as a new user if needed.

http://sensorcloud.com/log-in/

Figure 24 - SensorCloud™ Log-in or Register

The SensorCloud interface has six main views. When logging in as a registered user, the
Device view is the default. Navigate to other views by clicking the view name at the top of the
page (Figure 25 - SensorCloud™ Menu Views). The Data and Settings views are only
available once a device is selected from the device list.

Figure 25 - SensorCloud™ Menu Views

http://sensorcloud.com/login/
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Device - The device list shows every Ethernet gateway and API device associated with the
SensorCloud account, including owned, shared, and demo devices. This view provides links to
each device’s SensorCloud subscription plan, configuration options, and a summary of last
communications and data transactions.

Account - The account view is for logistic management of the SensorCloud account, such as
changing the log-in password, accessing user email, and reviewing billing information.

CSV Uploader - The data upload feature enables data from any source (such as non-Ethernet
LORD MicroStrain gateways, or third- party sensor) to be uploaded to the SensorCloud
platform. The datamust be in the LORD MicroStrain CSV format.

Data - This view is only available after a device is selected. It displays data that is collected
from sensor nodes or uploaded from files. Data selections are listed by node channel or a user-
defined label, and can be enabled for display in the graph window. The interactive graph has
navigational features such as panning, zooming, and an overview graph for single-click access
to data points or ranges. There are also use and management features such as viewing the
meta-data and downloading, embedding, and tagging data graphs.

Figure 26 - SensorCloud™ Data View

Settings - The settings view provides options for adding meta-data, configuring the data
displays for each channel, creating alerts based on data thresholds, setting the data timezone,
andmore.

MathEngine® - is used to analyze sensor data. Functions include the ability to filter out
frequencies, smooth out noisy data, performmath operations such as Fast Fourier Transforms
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(FFTs), and more (Figure 27 - MathEngine® View ) . MathEngine® interfaces with the
SensorCloud graphing view for faster processing. Users can write their own algorithms for
custom applications. Refer to theMathEngine®website for more information.

http://sensorcloud.com/mathengine

Figure 27 - MathEngine® View

Figure 28 - FFT Graph in SensorCloud™

For more information about SensorCloud features and navigation, refer to the SensorCloud
website or contact LORD MicroStrain Technical Support. 

http://sensorcloud.com

http://sensorcloud.com/mathengine
http://sensorcloud.com/mathengine
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3.9.2 Sensor Data Files

Data acquired in Node Commander or downloaded from the gateway is stored in .CSV
format and can be opened with Microsoft Excel, Quattro Pro, Open Office, or another CSV
editors/spreadsheet program.  Data in this format is easily uploaded to SensorCloud™
using the CSV Uploader. The data files can be found on the host computer in the default
directory or the location specified at the beginning of the sampling session (as applicable).
The files are organized in separate folders by mode and then further categorized by date,
session, and/or node serial number. 

The default directory is:C:\ProgramData\Microstrain\NodeCommander\Data

Synchronized sampling and low duty cycle files are found in the Sampled Data folder,
and streaming data is stored in the Streaming folder. Datalogging files need to be
downloaded from the node to be available for viewing. They are accessed through
datalogging menus as well as the File menu, and are saved in the Downloaded Triggers
folder.

Figure 29 - Exploring Data

NOTE

The Microsoft Excel the Time data column in the data file may have to be
changed to "m/d/yyyy h:mm:ss:000" format to make it more readable.
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4. Gateway Communication

NOTE

The default configuration of Ethernet gateways is for DHCP network
connectivity. In order to change the gateway communication settings initial
connection to a DHCP enabled network is required.

The gateway can be configured for the following Ethernet communication schemes:

l Automatically, through a DHCP-enabled local or wide area network (seeGateway
Configuration on page 13).

l By assigning the gateway a static IP address and connecting it directly to a host
computer (see Configuration on page 57).

l By assigning the gateway a static IP address and connecting it to a similarly configured
network (see Configuration on page 57).

l By connecting remotely through the SensorCloud™ web interface (see Remote
Connectivity on page 66).
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5. Gateway Configuration

To configure the gateway, connect to Control Panel through a web browser or Live Connect™

(seeGatewayOperation on page 13).

NOTE

The Control Panel log-in will expire after one hour of inactivity. Additionally
information that changes frequently, such as the System Time, Node List, and
Current Data Size are not updated automatically while logged in. The menus
are refreshed when navigating between menus, clicking on the web browser
Refresh button, logging out and back in, or when rebooting or cycling power to
the gateway.

There are three menu categories in gateway Control Panel: General, Data, and Tools. Within
each category are several menus. This section describes each menu in detail to assist in
configuration of theWSDA®-1500-LXRS®.

Figure 30 - Control Panel Menu Categories



WSDA®-1500-LXRS®Wireless Sensor Data AggregatorUserManual Gateway Configuration

37

View an overview and explanations of settings in a menu by selecting the + symbol above
the setting to expand the helpmenus.

Figure 31 - Help Menus

5.1 Gateway Information

The General category provides information about the gateway identity, the wireless nodes it
serves, and its current time settings. These are informational only, and no user adjustments
may be made in these menus. Table 3 - General Menus provides a summary of the menus
under the General category.

Menu Description
About Provides information about the gateway identity

Node List
Displays a list of wireless nodes for which the gateway is
currently storing data

Time Settings Provides time-related information

Table 3 - General Menus
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5.1.1 About the Gateway

The About menu provides information about the gateway. Each item is defined below.

Figure 32 - About Menu

Device Name: an alias given to the WSDA® -1500-LXRS® so that it is more easily
recognized in Live Connect™. By default, the device name is not assigned, and Live
Connect™ will use the device serial number as an identifier. The device name can be
changed in the Tool > Configurationmenu (see Configuration on page 57).

Serial Number: an alpha-numeric identifier embedded in the WSDA® - 1500-LXRS®

hardware. The serial number is assigned when the gateway ismanufactured.

MAC Address: an alpha-numeric identifier embedded in the network card of the WSDA®-
1500-LXRS® hardware. A MAC (Media Access Control) Address is a unique identifier
assigned to all Ethernet devices to manage communications on the network. The MAC
address is assigned when the gateway ismanufactured.

Model Number: an alpha-numeric identifier used to identify the gateway type. The model
number is assigned when the gateway ismanufactured.

OS Version: a numeric identifier used to identify theWSDA®-1500-LXRS®OS (Operating
System) Version. The OS is the on-board software that operates the WSDA® - 1500-
LXRS®. All gateways are shipped with the current OS version. As new features are added,
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OS updates are available from LORD MicroStrain® Technical Support (see Technical
Support on page 94) and installed by the user through the Tools > OS Upgrademenu (see
Operating System (OS) Upgrade on page 64).

Flash Card Utilization: the amount of memory currently consumed by data in the gateway
internal memory, and the total memory capacity. Data received from sensor nodes is stored
here.When capacity is reached, the flash card will begin overwriting data on a first-in, first-
out basis (older data is overwritten first).

Connection Type: the type of Ethernet connection the gateway is currently configured for -
DHCP or Static IP. This option and other settings can be changed in the Tools >
Configurationmenu (see Configuration on page 57).

System Time: the current UTC time on-board the WSDA®-1500-LXRS® system clock.
UTC (Coordinated Universal Time) is the time standard by which the world regulates clocks
and time. The system clock is normally updated from internet time servers every 12 hours.
For amore detailed discussion of the system and real time clocks see TimeOptions on page
61.

Synchronization Status: theWSDA®-1500-LXRS® is considered to be Synchronized if it
has successfully synchronized to one of its enabled time sources since it was booted, and
before any periodic synchronization has expired. Otherwise is considered to be Not
Synchronized. For a more detailed discussion of the system and real time clocks see Time
Options on page 61.

Last Synchronized Time: themost recent time when the gatewaywas synchronized to a
time source

Last Synchronized Source: the source fromwhich themost recent time synchronization
occurred

System Up-time: the elapsed time since the gatewaywas last powered on and booted up.
The system up-time will be zeroed when the gateway power is cycled or it is rebooted from
the Tools > Reboot menu.

System Resets: the number of times the gateway has been reset. System Resets will be
incremented when the gateway power is cycled or it is rebooted from the Tools > Reboot
menu. SystemResets are written to non-volatile memory and is preserved through power
outages.
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5.1.2 Node List

The node list displays all the wireless nodes that have data currently stored in the gateway
memory. The node address is shown along with the sensor channels that were configured
to transmit data to the gateway, the relative timestamp (time since the node sent its first data
to the gateway), and the last timestamp (the time of the most recent node data received by
the gateway).

Figure 33 - Node List
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5.2 Data Options Menu

The Data category provides data handling options such as selecting which data is sent to the
CAN J1939 bus, uploaded to SensorCloud™, and downloaded to a host computer. Data can
also be cleared from the WSDA® -1500-LXRS® internal memory. Table 4 - Data Menus
provides a summary of themenus under the Data category.

Menu Description

J1939
Enable and select what sensor data is sent out in
CAN J1939 format and what method is used

Upload Filter
Select which sensor nodes and channels are uploaded to
SensorCloud™

Calibration
Apply calibration conversions values and select
measurement display units before downloading saved data

Clear Data Erase data from the gateway flashmemory

Table 4 - Data Menus

Nomenclature for node address, channel assignments, and other data are used in some of the
Data menus. Table 5 - Data Nomenclature describes the required naming conventions for
these assignments. Node information found in the Node List are also annotated this way (see
Node List on page 40).

Field Description Nomenclature Examples

Address

Node address assigned when the
node ismanufactured. Provided
with the node and displayed in
Node Commander®when con-
nected

decimal number 31463

Channel

Channel
List

Payload

Data and packet value aliases such
as for node address, node channel
number, radio strength, and pro-
tocol values. Channel number
assignment is handled in Node
Commander®. All other aliases are
fixed (see Packet Definitions on
page 49).

lower case text
followed by a
number. In a
channel list mul-
tiple values are
separated by a
comma or space

ch1

ch1,ch2,ch5,
bin1, rssi

ch2 angleid

Table 5 - Data Nomenclature
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5.2.1 CAN J1939 Output

In addition to saving locally or uploading through an Ethernet connection, data acquired
from sensor nodes can also be pushed onto a CAN J1939 bus for reactive command and
control of external devices and other applications. By default the output is disabled. Enable
the output in the Tools > Configurationmenu see Configuration on page 57.

Settings

The J1939 menu includes CAN communication settings (J1939 Bus Configuration) and
output messages configuration (J1939 Broadcast Message Configuration) (see CAN J1939
Menu on page 42).

Figure 34 - CAN J1939 Menu

The bus configuration settings include theBaud Rate, dataSource, and dataDestination.

The baud rate is set as required by the host CAN bus that the gateway is integrated with.
The default is 250 kilobits per second (kbps), which is typical for most applications.
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NOTE

The wireless data transmit rate (between the node and the gateway) directly
impacts the data bandwidth on the CAN bus. If the aggregate transmit rate of
the wireless network (combined bandwidth use of active nodes) is high enough
and there are other devices (besides the gateway) on the CAN bus, the bus
may be overwhelmed, resulting in lost data. The gateway settings provide
no limitations to how much data is pushed onto the bus. If there are no
other devices on the CAN bus, this is not an issue, however it is up to the user
to determine the amount of data the bus can handle from each device.
Increasing the CAN bus baud rate and adjusting sensor sampling settings,
such as reducing sample rates and period, can be used to alleviate CAN bus
bandwidth limitations. Using the broadcast message data distribution method
and reducing the sensor data that is sent to the bus can also be effective.

The Source setting refers to where the data is coming from, as in, how theWSDA®-1500-
LXRS® will be recognized and addressed on the CAN bus (Figure 35 - Data Source
Setting).

l By setting the source toName, the gatewaywill acquire an address dynamically by
requesting it in sequential order, within the dynamic address range, until no other
device contests it (Table 6 - WSDA®-1500-LXRS® J1939 Values).

l By setting the source toAddress, the user can assign a static addresswithin the
gateway address range (Table 6 - WSDA®-1500-LXRS® J1939 Values). This
address is typed in the field next to the Source field, in place of the name.

Figure 35 - Data Source Setting
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With either setting the gateway will be identified by the name assigned to it when
manufactured (which is displayed to the left of the Source selection menu). This name
provides the host CAN buswith information about the device that determines its data priority
relative to other devices on the bus (Table 6 - WSDA®-1500-LXRS® J1939 Values).

Description Range
J1939 name

(assigned when manufactured)
0x8000FF0047200000

J1939 bus bit rate (user setting) 250 kbps (default), 500 kbps, 1Mbps
J1939 dynamic address range

(Source set to Name)
0x80 to 0xCF

J1939 static address range
(Source set to Address)

0x00 to 0xFF

Destination specific PGN
(Destination set to Name or Address)

0xEF00

Broadcast message PGN range
(Destination set to None)

0xFF00 to 0xFFFF

Table 6 - WSDA®-1500-LXRS® J1939 Values

The Destination setting refers to how the sensor data will be received on the CAN J1939
bus and the desiredmethod of sensor data distribution. Sensor data can be pushed onto the
bus either by sending all of the sensor messages to one CAN device (destination-specific),
or by broadcasting user-selectedmessages onto the entire CAN bus (broadcast).

l Destination-specific messages can be sent to either a CAN device Address or
device Name. Set Destination to either Name or Address and then type in the
device name or address (as applicable) into the Source field in hexadecimal format.
These are the only setting required for this type of messaging.

l For broadcast messages, the Destination is set to None and the user-designated
messages are constructed either in J1939 Broadcast Message Configuration
window or in a text file that is uploaded from themenu.

To change any of the settings, select from the drop down menus for each one and then
select the Save button to save the selected settings (Figure 35 - Data Source Setting).
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Broadcast Message Structure

The broadcast message uses the Society of Automotive Engineers (SAE) Parameter
Group Name (PGN) structure for the CAN J1939 data header, and the LORD MicroStrain®

Wireless Sensor Networks Data Communications Protocol structure for the sensor data
(see Reference Information on page 106). A message structure overview is provided in
Table 7 - Broadcast Message Format, and inmore detail below as required.

Field Description Format Range

PGN
SAE CAN J1939
header

hexadecimal 0xFF00 to 0xFFFF

Address
sensor node
address

decimal 1 to 65534
hexadecimal 0x0001 to 0xFFFE

Protocol
packet protocol
based on sensor
samplingmode

category name
LDC,
Synchronized,
Histogram

hexadecimal 0x04, 0x0A,0xA0
decimal designation 4, 10, 160

Payload
list of packet alias
values

text separated by
spaces

(example:ch1 ch2)

Ch Comp
channel for
conditional formula

text (example:ch1)

Condition
condition for
conditional formula

mathematical
operator

<, >, =

Value
threshold for
conditional formula

single precision
floating point

decimals within
format constraint

Table 7 - Broadcast Message Format

PGN: (Packet Group Name) unique hexadecimal packet identifier

Address: is the numerical address of the sensor node the data to be sent is from.
The node address is assigned when the node is manufactured. The number is
provided with the node and displayed in Node Commander®when connected.

Protocol: is the sensor data packet protocol used in each sampling mode. For
example Low Duty Cycle, Synchronized Sampling, and Histogram data formats are
currently supported. The protocol is designated by its name in the J1939menu or by
the decimal or hexadecimal equivelents in the text file.
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Payload: Payload are the data values to include in the packet. They are listed by
name in the sequence they will be sent. If the requested value cannot be found (for
example, if the nomenclature is wrong) the defined J1939 packet will not be sent. The
payload nomenclature and byte count follow the channel designations described in
the sampled packet definition (see Packet Definitions on page 49).

Ch Comp, Condition and Value: Use these fields to create a condition for which
packets will be sent onto the CAN bus. Ch Comp (Channel Compare) is the data
source for the condition formula, and the Condition and Value define what
mathematical operation to apply to it.

To enter the broadcast messages in the J1939menu, type in the appropriate field. When
the PNG field is selected, the Payload field will appear. If all values for the message are to
be included, leave the Ch. Comp, Condition and Value fields blank . Select Apply at the end
of the row to save the message designations. Once all designations are entered, click the
Submit button to save the configuration (Figure 34 - CAN J1939 Menu ). To save the
configuration for future use, download to a file using the Download button.

Figure 36 - Broadcast Message Menu Example
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To use a text file, structure the data in the following format. Leave fields blank if all values
are to be included.

[PGN]
NodeAddress=value
Protocol=value
Variant=value
Payload=value
Condition=channel name:operator:value

EXAMPLE:

Node 31463 was sampled in low duty cycle mode. Sensors are connected to channel 1,
channel 2, and channel 3. For channels 1 and 3 all data measurements will be sent to the
CAN bus. For the sensor on channel 2, only data values over 1.8 will be sent.

[0xFF00]
NodeAddress=31463
Protocol=4
Payload=ch1 ch3

[0xFF01]
NodeAddress=35
Protocol=4
Payload=ch2
Condition=ch2:>:1.8

Once created, save the text file and then upload it to the gateway by clicking the Browse for
File button in the J1939menu. Navigate to the file, clickOK, and then click the Submit button
to save the configuration (Figure 37 - Upload Configuration File).

Figure 37 - Upload Configuration File
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Host Bus Integration

Data packets received from the sensor nodes will be passed onto the J1939 CAN bus as
received. An integrity check is made before sending the packet over the bus, but no other
process is applied before wrapping the data in the J1939 protocol. The receiving
CAN J1939must be capable of responding to Transport Protocal ConnectionManagement
(TP.CM). Only one sensor data packet will be sent in each TP.CMexchange.

The destination will need to understand the LORD MicroStrain®Wireless Sensor Networks
Data Communications Protocol for Low Duty Cycle (LDC), Synchronized Sampling, and
Histogram packets (see Packet Definitions on page 49 ). Because J1939 only supports
payloads of 8 bytes, sensor data packets will be broken up into multiple J1939 packets as
required. In this scenario 7 bytes of sensor data packets are sent with a 1 byte J1939
sequence number to indicate its position in the string of sensor data. This is done
automatically and will appear seamless on the receiving end. All the destination device
needs to understand is the LORD MicroStrain® packet structure of each sensor data packet
in order to determine how to parse the incoming data (see Packet Definitions on page 49).
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Packet Definitions

The following tables summarize the sampled data packet structure in the LORD
MicroStrain®Wireless Sensor Networks Data Communications Protocol . All data is in big
endian format unless otherwise noted. Refer to the LORD MicroStrain® Wireless Sensor
Networks Data Communications Protocol Manual for more information (see Reference
Information on page 106).

Low Duty Cycle (Protocol 4)

Description Hex Value Value Alias
Number of
Bytes

Data
Type*

Start of packet 0xAA sop 1 uint8
Delivery stop

flag
0x07 delflags 1 uint8

App data type
(data protocol)

0x04 appdatatype 1 uint8

Node address 0x1 to 0xFFFE nodeaddress 2 uint16
Payload length 0x2 to 0x6A payloadlength 1 uint8
App ID 0x02 appid 1 uint8

Channel mask 0x0 to 0xFF channelmask 1 uint8
Sample rate 0x1 to 0x7B samplerate 1 uint8
Data type 0x1 to 0x4 datatype 1 uint8
Timer tick 0x0 to 0xFFFF tick 1 uint16

Channel data
0x0 to
0xFFFFFFFF

(examples:
ch1, ch2, ch8)

4
uint16,
uint32,
float

Node radio sig-
nal strength
indicator (RSSI)

0x0 to 0xFF rssi 1 uint8

Base Station
radio signal
strength indic-
ator (RSSI)

0x0 to 0xFF 1 uint8

Checksum 0x0 to 0xFFFF 2 uint16

*Data type values
uint8 = 1 byte unsigned integer
uint16 = 2 byte unsigned integer
uint32 = 4 byte unsigned integer
float = 4 byte float
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Synchronized Sampling (Protocol 10)

Description Value Value Alias
Number
of Bytes

Data
Type*

Start of packet 0xAA sop 1 uint8
Delivery stop

flag
0x07 delflags 1 uint8

App data type*
(data protocol)

0x0A appdatatype 1 uint8

Node address 0x1 to 0xFFFE nodeaddress 2 uint16
Payload length 0x02 to 0x6A 1 uin8
Sample mode 0x1 to 0x2 samplemode 1 uint8
Channel mask 0x0 to 0xFF channelmask 1 uint8
Sample rate 0x1 to 0x7B samplerate 1 uint8
Data type 0x1 to 0x4 datatype 1 uint8
Sweep tick 0x0 to 0xFFFF tick 2 uint16

UTC timestamp
(seconds)

0x0 to
0xFFFFFFFF

utcseconds 4 uint32

UTC timestamp
(nanoseconds)

0x0 to
0xFFFFFFFF

utcnanoseconds 4 uint32

Channel data
0x0 to
0xFFFFFFFF

(examples: ch1,
ch2, ch8)

4
uint16,
uint32,
float

Node radio sig-
nal strength
indicator (RSSI)

0x0 to 0xFF noderssi 1 uint8

Base Station
radio signal
strength indic-
ator (RSSI)

0x0 to 0xFF rssi 1 uint8

Checksum 0x0 to 0xFFFF 2 uint16

*Data type values
uint8 = 1 byte unsigned integer
uint16 = 2 byte unsigned integer
uint32 = 4 byte unsigned integer
float = 4 byte float
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Histogram (Protocol 160)

Description Value Value Alias
Number
of Bytes

Data
Type

Start of packet 0xAA sop 1 uint8
Delivery stop flag 0x07 delflags 1 uint8
App data type*
(data protocol)

0x04 appdatatype 1 uint8

Node address
0x1 to
0xFFFE

nodeaddress 2 uint8

Payload length 0x-- payloadlength 1 uint8
App ID 0xA0 appid 1 uint8
Angle ID 0x0 to 0x2 angleid 1 uint8
Mode 0x0 to 0x1 mode 1 uint8
Bin size 0x---- binsize 2 uint16

Bin lower bound 0x---- binlowbound 2 uint16
Data set ID number 0x---- dataid 2 uint16

Uptime 0x---- uptime 4 uint32
Angle 0x---- angle 4 float
Life 0x---- life 4 float

Binned data

bin1, bin2,
bin3,….
bin19, bin20,
bin21

84 uint32

LQ1 0x0 to 0xFF lqi 1 uint8
Radio signal

strength indicator
(RSSI)

0x0 to 0xFF rssi 1 uint8

Checksum
0x0 to
0xFFFF

2

Histogram packets values
Byte 9 (Mode): 0=normal, 1=idle
Byte 10-11 (Bin Size): Size of each bin (in engineering units)
Byte 12-13 (Bin Lower Bound): Start of bin 1 (in engineering units)
Byte 14-15 (Data Set ID #): Each data set ID is used for 3 sets of binned data
Byte 16-19 (Uptime): 1 count is 1/32 second
Byte 20-27 (Angle): Floating point angle in radians
Byte 28-111(Binned data): Binned data consists of 21 bins. Each bin is represented by a 4
byte unsigned integer
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5.2.2 SensorCloud™ Upload Filter

By default, the WSDA® - 1500-LXRS® uploads all sensor data stored in the gateway
memory to SensorCloud™. The Upload Filter function allows the user to filter which node
data is to be uploaded.

Figure 38 - Data Upload Filter

The Upload Filter menu describes how to set up a filter. Nodes and node channels can be
collectively set to be included (Only Upload the Listed Channels) or excluded (Do Not
Upload the Listed Channels) by using the Change Filter Type button. For address and
channel nomenclature see Data Options Menu on page 41. The Upload Filter can be set
before or after data upload has been initiated. If data has already been received from the
node, refer to the Node List to verify which node and channel data has been saved. Use the
Clear All button to delete all node filters.

NOTE

TheChange Filter Type function affects all nodes in the filter list. When applied,
it sets all nodes in the list and cannot be used for individual nodes.
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5.2.3 WSDA® Data Downloader Calibration Coefficients

The Calibration feature allows the user to specify coefficients for converting between
engineering units with a linear relationship, and to correct for sensor biases in sensor data
saved in the gatewaymemory.

The coefficients are applied when data is downloaded from the gateway to a host computer
using the WSDA® Data Downloader and are in addition to any conversion values assigned
to the sensor channel during node configuration (see Channel Configuration on page 22 as
well as the applicable node User Manual). This feature is particularly useful for porting
collected data into third party applications like Microsoft Excel, custom software, or data
analytic software when different coefficients are desired than what was used when the data
was acquired.

Figure 39 - Calibration Menu

The data to apply the coefficients to is designated by entering the source node address and
channel numbers. For the nomenclature used for the address and channel see Data
OptionsMenu on page 41. The coefficient values are entered for the designated channels.
The values for each are described below and are also available in the calibration help
menus accessible by clicking the + symbol next to Field Definitions (Figure 39 - Calibration
Menu). To use the Calibration feature, click the Add button after entering the desired values
in each field.
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Address: sensor node address

Channel: sensor channel on the designated node

The calibration conversion formula assumes a linear relationship between the original units
(such as A/D bits) and new engineering units (such as ), and it is expressedmathematically
as y=mx+b, where y is the engineering units at a given point (measurement), m is the slope
of the line that represents the linear ratio, x is the original unit value at a given point, and b is
a unit conversion offset (in the case of unit conversions) or the fixed zero load offset of the
sensor (in the case of measurement calibration coefficients). Negative values may be
entered for any coefficient.

Slope: is the linear scaling slope coefficient. The slope is the ratio of original units to new
engineering units (EU), and it is used to convert the sensor measurements. The slope
conversion value will vary depending on the engineering units desired. For example if the
original unit is A/D values (bits), and the desired engineering units are acceleration in g-
force, the slope conversion would describe how many bits equal one unit of g-force (bits/g).
Mathematically, the slope ism in the formula y = mx +b.

Offset: is the linear scaling offset coefficient, and it is typically the starting output value of the
sensor with no load applied (in the original units). Mathematically, the offset is b in y = mx +b.

Low Limit: optional data threshold value that will generate a data-out-range indicator if
measurement is below the value

High Limit: optional data threshold value that will generate a data-out-of-range indicator if
measurement is above the value

Unit: user defined long name of calibrated unit

Symbol: user defined short name of calibrated unit

EXAMPLE:

Sensor node 34163 ismeasuring temperature in degreesCelsius on channel 1. Calibrated
data is desired to be in Fahrenheit with indicators if the measurement goes below 0 F or
above 100 F. The conversion for Celsius to Fahrenheit is: F = C*1.8 +32 (y = mx +b)

Address Channel Slope Offset
Low
Limit

High
Limit

Unit Symbol

34163 ch1 1.8 32 0 100 Fahrenheit F
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5.2.4 Clear Stored Data

The Clear Data feature is used to erase all sensor node data from the gateway's internal
memory. Before erasing, the user should confirm that all data has been transmitted to
SensorCloud™. The Current Data Size display indicates the amount of data currently
stored in thememory.

To clear data click the Clear All Data button, and the data will be erased.

Figure 40 - Clear Data Menu

5.3 Gateway Tools Menu

The Tools menus provide the user a means to configure, troubleshoot, and update the
WSDA®-1500-LXRS® settings. Table 8 - Tools Menus provides a summary of the menus
under the Tools category.

Menu Description
Diagnostics Reports results of periodic diagnostic checks

Configuration
Gateway settings adjustments such as communications
configuration, device naming, and enabling and disabling of
gateway features

Time Options
Configuration options related to how the gateway retrieves
and uses time

Reboot Restart and reinitialize the gatewaywithout cycling power
OS Upgrade Update the operating system software on the gateway

Change Password
Change the user name and the password required at log-in
to the gatewayControl Panel

Table 8 - Tools Menus
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5.3.1 Diagnostics

The diagnostics feature is used to troubleshoot theWSDA®-1500-LXRS®. The diagnostics
window displays a report from the gateway internal log file. The log records the diagnostic
checks from three possible sources of error: the timing engine, SensorCloud™ data upload,
and the data logger. These diagnostic checks are performed once at every power up and
then periodically as the gateway is in on. If errors are reported in the Diagnostics menu,
contact LORD MicroStrain® Technical Support (see Technical Support on page 94).

Figure 41 - Diagnostics Menu

NOTE

If SensorCloud™ Data Upload, J1939, or Data Logging are disabled (in the
Tools > Configuration menu) they will not be checked during the diagnostics
routine.
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5.3.2 Configuration

TheConfigurationmenu allows the user to set parameters associated withWSDA®-1500-
LXRS® operation. The settings include configuring the communication settings, enabling
and disabling operating sequences, changing the node synchronization beacon state, and
changing the gateway wireless node communication frequency. Each setting is described
below in detail.

Figure 42 - Configuration Menu

Device Name: The device name in an alias given to the WSDA®-1500-LXRS®, so it is
more easily recognized. By default, the device name is not assigned. To enter a name, type
it into the field and click the Save button.

Local Live Connect™: The Local Live Connect™ setting allows users to disable Live
Connect™ on the local network. This is important if data security is a concern. Disabling
Live Connect™ prevents other users on the network from accessing the data stream . If Live
Connect™ is disabled it will not be available for connecting to Node Commander® unless
done remotely through SensorCloud™ (see Remote Connectivity on page 66). The default
is for Live Connect™ to be enabled.
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Data Logging:Data logging saves acquired data to the gateway internal memory, and also
makes it available to the CAN J1939 Bus, SensorCloud™, and a host computer through
Live Connect™ . Disabling data logging will prevent data only from being stored in the
gateway internal memory and from being uploaded to SensorCloud™. The data will still be
available to Node Commander® through Live Connect™ and for the CAN J1939 bus. The
default setting is that all data logging is enabled.When data logging is enabled the gateway
waits for time synchronization ( see Time Options on page 61 ), sets the node
synchronization beacon, sets the gateway wireless node communication frequency, and
then begins logging data.

WSN Beacon: The beacon is used to precisely coordinate node data acquisition and data
transmission in the wireless sensor network (WSN)  during synchronized sampling (see
Using the Beacon on page 77).

WSN Channel: The channel setting refers to the wireless sensor network (WSN)
transmission frequency between the gateway and the node. There are 14 available
channels between 2.405 and 2.470GHz.

NOTE

l The gateway can automatically manage nodes operating on different
frequencies by using the Node Discovery feature in Node Commander®. In
this routine, the gateway listens for node broadcasts on the frequency
channel to which it is set. If the node is in normal boot-upmode, it will provide
the broadcast when it is initially powered-on, and it will broadcast on all
channels. As long as the node is powered-on after activating the Node
Discovery feature, the gateway will link to it and remember the channel
setting for future node queries.

l Manually matching the node and gateway frequency channels is required in
some applications. For example, when sending broadcast messages from
the gateway tomultiple nodes (including the synchronized sampling beacon)
all nodesmust be on the same channel as the gateway in order to receive the
broadcast. Assigning channels is also a good idea when multiple gateways
are attached to one host computer or when other wireless equipment is
nearby and frequency or transmission interferencemay occur.
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This setting can also be set temporarily in Node Commander® (See Transmit Frequency on
page 73), but will default to the Control Panel setting when the gateway is powered off or
rebooted. To change the frequency the gateway will use on boot-up, us the Control Panel
Setting. The default setting is Channel 15 (2.425GHz).

Network Mode: The network mode determines whether the gateway has a dynamic or a
static IP address, which is used to identify it on the network. A dynamic, or DHCP network,
automatically assigns the gateway an IP address. The static IP setting allows manual
assignment of the IP address. A static IP address is required if the network does not have a
DHCP server or if the gateway will be connected directly to a host computer and not used
on a network. The default setting is for a DHCP network.

If Static IP is selected, additional menu settings will appear (Figure 43 - Static IP Settings).
The Static IP Address is the IP Address to which the gateway will be assigned. This
cannot be the network address or the broadcast address of the subnet. TheStatic Subnet
Mask defines the range that the gateway can communicate (on the subnet). For example, if
the gateway IP Address is 192.168.0.100, and the subnet mask is 255.255.255.0 the
gateway can communicate with all addresses between 192.168.0.0 and 192.168.0.255.
The Static Gateway option allows users to define an address the gateway can
communicate with outside of its subnet. This requires the gateway to be able to access the
internet on a static network.

Figure 43 - Static IP Settings

To setup the host computer for direct communicationswith the gateway, the host computer
IP address must be changed so that it has the same subnet as the gateway. The gateway
subnet in the example above is the first three sets of numbers in the IP address (192.168.0).
The last set of numbers (100 in the example) will be the unique identifier for each device on
the network (the gateway, computer, and other deviceswill each have a different number).
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To change the IP address on a computer with aWindow operating system, try the following
steps:

1. Find the active Local Area Connection. Go to the Control Panel, and click on the Net-
work Connections folder.

2. Right-click on the active Local Area Connection, and select properties.

3. Scroll down, and double-click on Internet Protocol (TCP/IP).

4. In the window select Use the Following IP Address.

5. Enter the subnet into the field entitled IP Address, and add a fourth number. It can
be any number between 0 and 255, except the number that the gateway or any
other device on the network is using.

6. In the Subnet Mask field, enter 255.255.255.0.

7. Save and exit themenus. Setup is complete.

J1939: The J1939 CAN output allows sensor data to be pushed out to a user-designed
J1939 CAN bus through the WSDA® - 1500-LXRS® multi- port connector. For more
information see CAN J1939Output on page 42. The default setting is for the J1939 output to
be enabled.

SensorCloud: The SensorCloud™ feature allows enabling and disabling of the
transmission of sensor data from the gateway internal memory to the web- based
SensorCloud™ database. It also allows remote access to the gateway Control Panel
through Live Connect™ (see Remote Connectivity on page 66). When enabled the gateway
will upload newly received data to SensorCloud™ at two minute intervals. In other words, it
will transmit new data, wait two minutes, and then transmit any additional new data. The
overall transmission time varies with sampling settings, quantity of data, and internet
connection speeds.
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5.3.3 Time Options

The Time Options menu allows configuration options related to how the gateway retrieves
and uses time. TheWSDA®-1500-LXRS® has two on-board clocks: the System Clock and
the Real Time Clock (RTC). The purpose of the System Clock is to provide the operating
systemwith a time source. The purpose of the Real TimeClock is to provide time updates to
the SystemClock and to provide a reference for the node synchronization beaconing
function.

During normal operation, the WSDA®-1500-LXRS® synchronizes time from enabled time
sources starting with the most accurate. On boot-up, the WSDA®-1500-LXRS® will try to
get a new time. If it is unable to, it will check to see if it already has a non-expired time from
the first source. If not it will move on to the next source. During boot-up theWSDA®-1500-
LXRS® must successfully synchronize time before it can begin data acquisition. Once
synchronization has occurred, the WSDA®-1500-LXRS® will continue to query the time
source every hour, however synchronization is not required to continue data acquisition.
Manually setting time on the WSDA ® - 1500- LXRS ® will immediately override any
synchronization attempts and allow data acquisition to start.

Figure 44 - Time Options Menu

TheWSDA®-1500-LXRS® can synchronize its system time from four different time
sources: Network Time Protocol (NTP) time servers, manual user entry, the last known
time reference, or from an attached device with GPS.
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l Time servers allows theWSDA®-1500-LXRS® to synchronize with external
servers that provide the NTP service. A list of time servers is provided and can be
modified by the user. This option requires connection to a NTP server and is the
most accurate time source (with the exception of GPS).

l Manual time synchronization utilizes a time entered by the user. Enter the time in
the SystemTime field, and select the Set SystemTime button.

l Last Known synchronizes to the last time recorded on theWSDA®-1500-LXRS®.
This could be from the internal Real TimeClock (RTC) or a file on the gateway.

l GPS allows theWSDA®-1500-LXRS® to synchronize with a compatible external
GPS device for extremely accurate time.

NOTE

UsingGPS as a time source is only available in the TimeOptions menuwhen a
GPS integrated device, such as a LORD MicroStrain® GPS enabled inertial
sensor, is connected to the WSDA®-1500-LXRS® customization serial port.
For more information refer to see Recommended Sensors on page 97 or
contact LORD MicroStrain® Technical Support (see Technical Support on
page 94).

To select the time source check the Enabled check-box next to the source name in the Time
Sources menu. Each time source also has an accuracy field and an expiration field.
Accuracy is fixed and dependent on the source. Expiration represents how long the time
synchronization is valid for, and it is set by the user.

System Time displays the current time being used by the gateway. Time can bemanually
entered by typing directly into the field and selecting the Set System Time button. This
function is normally used when no other time source (Time Servers, GPS, etc.) is available.
If the time is set forwardmore than an hour from the host computer, the Control Panel web
session will be expired and the user will have to log in again.

The Time Servers selections allows the user to set which time servers the gateway uses to
synchronize time, and in what order it attempts to do so. The time servers are displayed in a
list with the first server, order 0, being the first server checked. The time server must support
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NTP for the gateway to use it. The WSDA®-1500-LXRS® comes pre-configured with some
known time servers.

To insert a new time server, fill in the last line Order columnwith the numerical order to place
the time server in the list. Next enter the host name of the time server in the Hostname
column. Click the Insert button.

To delete a time server locate the time server in the list, and click the Delete button next to it.

To change the order of an existing time server locate the time server on the list, and enter
the new order number in the Order column. Click Apply. Other servers with the same
numerical designation will automatically bemoved.

5.3.4 Reboot

TheReboot option allows the user to restart and reinitialize the gatewaywithout cycling
power.

To reboot the WSDA® -1500-LXRS® , select the Reboot button. A three stage boot-up
sequence will start, as described in Table 9 - Reboot Indicators. The boot-up process will
take between two and threeminutes. Once booted, log in into the Control Panel as normal.

Stage
Indicator Behavior

CLOUD WSDA POWER
Initial Power On ON red ON red ON green
Booting Up ON red flashing blue ON green

Fully Booted
ON green and/or
flashing blue

ON green ON green

Table 9 - Reboot Indicators
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5.3.5 Operating System (OS) Upgrade

Periodically, new versions of the WSDA®-1500-LXRS® operating system will be released
to add features or make other updates to the system. On the recommendation of LORD
MicroStrain® Technical Support, gateways can be upgraded to the latest available
operating system to take advantage of these new features or to correct operating
issues. Updatesmay be found on the LORD MicroStrain® website (see Technical Support
on page 94).

Figure 45 - OS Upgrade Menu

1. Download the upgrade file from the LORD MicroStrain ® website or LORD
MicroStrain® Technical Support.

2. As needed, extract the contents of the zip file into a folder on the computer.  Verify
there is a file with a .wsda_os extension.

3. Select the OS Upgrade button in the gatewayControl Panel.

4. Select the Browse button, and navigate to the folder containing the update file
provided (example: firmware_v2.3.3.wsda_os).

5. Select the Open button, and then Upload. There are two parts to the upgrade: the
upload and the actual upgrade. Once the upload reaches 100%, the status bar will
reset and begin the upgrade process status. The entire upgrade can take fifteen to
twentyminutes.
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5.3.6 Change Password

TheChange Password feature is used to change the username and the password required
at log-in to theWSDA®-1500-LXRS®Control Panel.

The default username and password are:
a. Login: wsda
b. Password: wsda

Enter the current username and password and then the new password twice and select
Submit.

Figure 46 - Change Password Menu
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5. Remote Connectivity

SomeSensorCloud™ data plans allow remote access to the WSDA®-1500-LXRS® through the
SensorCloud™ web interface. This allows access to the gateway Control Panel (including data
downloading) and to Live Connect™ and Node Commander ® for remote configuration of
gateways and nodes. Data downloading from the gateway memory is also available in this way.
Access is obtained through a secure web interface, although local installations of Live Connect™

and Node Commander® are required on the host computer to access the nodes.

To begin, log in to SensorCloud™ (see Connecting to SensorCloud™ on page 31).

Access the Control Panel Remotely

1. While in SensorCloud™ open the Devicesmenu, and select the device Con-
figuration link (Figure 47 - GatewayConfiguration).

Figure 47 - Gateway Configuration

2. Select the Control Panel button (Figure 48 - Device Control Panel Access). If it is
not present, the SensorCloud™ account does not include the feature andmust be
upgraded.

3. Log in to the Control Panel when prompted. All Control Panel features are now avail-
able (seeGatewayConfiguration on page 36).
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Figure 48 - Device Control Panel Access

Download Data Remotely

1. To remotely download data from the gatewaymemory, connect to the gatewayCon-
trol Panel as described above.

2. Copy the URL from the browser address bar when in Control Panel (Figure 49 -
Control Panel URL).

3. Open theWSDA®Data Downloader program and paste the address into the
WSDA URL field.

4. Enter the log-in credentials for Control Panel, and select Connect toWSDA.

5. Enter SensorCloud™ credentials when prompted, and useWSDA®Data Down-
loader as normal (seeWSDA® Data Downloader on page 80).

Figure 49 - Control Panel URL



WSDA®-1500-LXRS®Wireless Sensor Data AggregatorUserManual Gateway Configuration

68

Access Live Connect™ Remotely

1. In the device configurationmenu, select the Live Connect™ button (Figure 50 -
Device Live Connect™ Access). If the button is not present, the SensorCloud™
account does not include the feature andmust be upgraded.

Figure 50 - Device Live Connect™ Access

2. When the button is selected a file download (info.live_connect) will begin. Open the
file when the download is complete, and Live Connect™will open automatically.
The device will appear in the Live Connect™window under User DefinedWSDA's
(Figure 51 - Remote Live Connect™ Connection).

3. Use Live Connect™ to connect to the gateway control panel (seeGatewayControl
Panel on page 15) or to Node Commander® (see Connecting to Node Com-
mander® on page 17) as normal.

Figure 51 - Remote Live Connect™ Connection
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6. Using Node Commander®

NodeCommander® is used to configure sensors nodes, set sampling parameters, and begin data
acquisition. This section describes how to verify communication with the gateway in Node
Commander® and adjust wireless communication settings. For an overview of Node
Commander® node and data acquisition menus and access through Live Connect™ , see
Connecting to Node Commander® on page 17. For detailed settings information, refer to the
Node Commander®User Manual (see References on page 106).

When a gateway is communicating with the host computer in Node Commander® it will appear on
a list in the Controller window with a name that includes the communications port for which it is
configured and an icon symbolizing the type of communication interface.

Node Commander® remembers gateways and nodes that have been communicated with
previously. They will appear on the list when the software is started, however the name and icon
will be grayed out if the device is not currently communicating. To remove a gateway that is no
longer used, select Remove Base Station from the gatewaymenu.

Right clicking on the gateway name will produce a list of menu options available for the gateway .
Figure 52 - Gateway Communication shows an Ethernet gateway that is communicating on
ComPort 1, with the correspondingmenu and a serial gateway that is not connected.

Figure 52 - Gateway Communication
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6.1 Verify Gateway Communication

The Verify and Reverify Base Station commands can be used to check the communication
status of the gateway to the host computer. The Verify command is available in the gateway
menu if no communication has been previously established. The Reverify command is in the
gatewaymenu if communication has already be established, and it is used to check the current
status. Right-click on the gateway name, and select the command.

Figure 53 - Verify Gateway Communication

6.2 Gateway Communication Timeout

NodeCommander®will attempt to establish communication with the gateway for the amount of
time set as the communication timeout; the default setting is 20 milliseconds. If communication
cannot be established, try adjusting this value for a longer timeout. Right-click on the gateway
name, and select Configure > Configure Timeout. Adjust the value, and then select the Test
Value button to test the communication to the gateway (Figure 54 - Communication Timeout).
This feature can also be used if communication to the node is intermittent.

Figure 54 - Communication Timeout
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6.3 Removing a Gateway

To remove a gateway that is no longer used, right-click on the gateway name in the Controller
window, and select Remove Base Station from the gatewaymenu .

Figure 55 - Removing Gateways

6.4 Gateway Information

Gateway information (such as the model type, serial number, radio type, operating frequency,
current communications port, and firmware revision) is found in the gateway Information
window. Right-click on the gateway name and select Configure > Configure Base Station.

There is also a Label field to give the gateway a unique name, which is useful when there are
multiple gateways in the system. Gateway transmit power can also be selected in this window.
For additional information see Transmit Power on page 72.

Figure 56 - Gateway Information and Name
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6.5 Transmit Power

The transmit power level may require adjustment if power consumption is a concern or in
regionswhere there are transmit power restrictions. Lowering the power output reduces power
consumption, but it also reduces the wireless communication range between the gateways and
nodes.

NOTE

Actual range is highly dependent of how the nodes and gateways are installed and the
conditions in the surrounding environment (see Range Test on page 83).

Setting Power Output
Maximum
Range

Extended 16 dBm (39mW) 2 km
Standard 10dBm (10mW) 1 km
Low 0dBm (1mW) 70m

Table 10 - Transmit Power Settings

The transmit power setting for the gateway is found in the gateway Configure Base Station
menu.

Figure 57 - Transmit Power Setting
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6.6 Transmit Frequency

The transmit frequency of the wireless sensor network refers to the communication link
between the gateway and the node. There are 14 available frequency channels between 2.405
and 2.470GHz.

NOTE

l The gateway can automatically manage nodes operating on different frequencies
by using the Node Discovery feature in Node Commander®. In this routine, the
gateway listens for node broadcasts on the frequency channel to which it is set. If
the node is in normal boot-up mode, it will provide the broadcast when it is initially
powered-on, and it will broadcast on all channels. As long as the node is powered-
on after activating the Node Discovery feature, the gateway will link to it and
remember the channel setting for future node queries.

l Manually matching the node and gateway frequency channels is required in some
applications. For example, when sending broadcast messages from the gateway to
multiple nodes (including the synchronized sampling beacon) all nodes must be on
the same channel as the gateway in order to receive the broadcast. Assigning
channels is also a good idea when multiple gateways are attached to one host
computer or when other wireless equipment is nearby and frequency or
transmission interferencemay occur.

The frequency setting for the gateway can be changed from the Configuremenu.

Figure 58 - Gateway Frequency
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NOTE

Setting the transmit frequecy using Node Commander® is temporary for Ethernet
gateways and will revert back to the frequency setting selected in the gatewayControl
Panel when the gateway is powered off or rebooted (see Gateway Configuration on
page 13 for how to change the frequency setting in Control Panel)

6.7 Monitor Mode

Monitor mode is used to observe any low duty cycle and synchronized sampling activity that is
occurring on nodes connected to a particular gateway. When monitor mode is selected, the
sampling window opens and displays the data. This is useful if the node was configured to start
sampling on boot up or if the data acquisition screen was closed without stopping the node. It is
a way to enter the data and graph view windows after data acquisition has already begun. The
gateway will only monitor nodes that are on the same frequency (channel) that it is on. All
nodes on that frequencywill automatically be displayed.

Tomonitor a node, right click on the gateway name and select Monitor Mode.

Figure 59 - Monitor Mode
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6.8 Network Broadcast

The network broadcast feature is used to send the same command at the same time tomultiple
nodes connected to the same gateway. Nodes must be on the same transmission frequency
(channel) as the gateway to receive broadcast commands. Network broadcast functions
include communications, sampling, and configuration commands.

Network broadcast commands are found in the gateway menu. Right click on the gateway
name, and select Network Broadcast. Then select the desired category and command.

Sample

l Synchronized Sampling Start

l Low Duty Cycle Start

l ArmedDatalogging

l Trigger Datalogging Session

l Erase

Communicate

l Ping

l Stop Node

l WakeNode

l Sleep

l Cycle Power

Configure Figure 60 - Network Broadcast Commands

l Read/Write EEPROM
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6.9 Node Configuration

Node configuration is completed exclusively in Node Commander®. For an overview of sensor
configuration andmenus see Connecting to Node Commander® on page 17.

For additional node configuration, refer to the Node Commander® user manual ( see
Reference Information on page 106).
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6. Using the Beacon

In synchronized sampling, the beacon feature is used to coordinate sampling and
transmission timing betweenmultiple nodes. The primary purpose is to avoid data collision,
guarantee timing between samples from different nodes, and to time-stamp the data. The
beacon cannot be used in any another samplingmode.

When the beacon is enabled, the gateway broadcasts a data message once every second
containing a Coordinated Universal Time (UTC) time stamp, and it is used to update each
node’s real time clock (RTC). This continuous synchronization beacon, coupled with the
accuracy of the gateway and node clocks (+/- 3 ppm drift), provides a node- to- node
synchronization within +/-32 microseconds. The gateway receives the UTC from the host
computer, so the host must be connected to a UTC time server to achieve that accuracy.
There is some lag inherent in the Microsoft Windows distribution of the UTC. This dictates
the overall accuracy of the time-stamp, but the synchronization times between the gateway
and nodeswill be consistent because of the accuracy of the embedded RTC clocks.

Nodesmust be on the same transmission frequency (channel) as the gateway to receive the
beacon broadcast command. When the beacon is active, the gateway device status
indicator will pulse blue once per second. When the nodes connected to the gateway are in
synchronized samplingmode, the network can be put to sleep by turning off the beacon and
then resuming transmitting once the beacon is enabled. Any node that is actively sampling in
synchronized sampling mode on the same frequency as the gateway will synchronize to it
automatically if the beacon is activated.

To avoid interference with other devices it is recommended that the beacon be disabled
when not in use. Do not operatemultiple gateways on the same frequency.

To enable and disable the beacon using the gateway control panel see Configuration on
page 57. Alternately, the beacon can be activated from the synchronized sampling window
when sampling is started, and stopped with the stop node commandwhich can be executed
when sampling is ended (see Data Acquisition on page 25 and refer to the Node
Commander®User Manual for more information ).

6.10 System Bandwidth in Synchronized Sampling

When using synchronized sampling all nodes in the wireless network are queried and given
time slots of various lengths based on their configuration (# of channels, sample rate, etc.).
Nodeswill only transmit data during these time slots, therefore eliminating over-the-air data
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collisions. The total time available for node transmissions is defined by the system
bandwidth. Because the system bandwidth is finite, only a fixed number of nodes can be
supported when using synchronized sampling. The number of nodes is largely dependent
on node configuration, as each consumes part of the bandwidth. Use the online network
bandwidth calculator to determine the bandwidth capacity for a particular system
configuration: http://www.microstrain.com/configure-your-system

6.11 Synchronized Sampling with Multiple Gateways

If there aremultiple gateways in the system, a Global Positioning System (GPS) time source
can be used to synchronize time between the gateways. Only gatewayswith attachedGPS
devices, such as a LORD MicroStrain®GPS or GNSS-enabled inertial sensor, will have this
option (see Recommended Sensors on page 97). The gateway-to-gateway synchronization
for systems using theGPS time source is on the order of micro-seconds.

Another option available on the WSDA® -1500 - LXRS® gateway is to use an NTP time
reference from the internet. As there is lag inherent to using the internet to get a NTP time, it
is not recommended for synchronizing multiple gateways. This option would have a
gateway- to- gateway synchronization on the order of 10’s of milliseconds. A good
compromise would be to use of a local NTP time reference. This would reduce the gateway-
to-gateway lag tomilliseconds. For information on how to adjust the times settings see Time
Options on page 61.

http://sensorcloud.com/pricing?showCalculator=true
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7. Data Processing

Data acquired through Node Commander® is automatically saved on the host computer (see
Sensor Data Files on page 34). Data can also be uploaded or automatically ported to the LORD
MicroStrain®SensorCloud™ web platform for near- real time display, monitoring, data storage,
and analysis (Figure 61 - Data Visualization and Analysis).

SensorCloud™ is based on cloud computing technology and is designed for long term collection
and preservation of data. Features include time series and visualization graphing, automated
alerts, and data interpretation tools such as data filtering, statistical analysis, and advanced
algorithm development with the integratedMathEngine® interface. Basic SensorCloud™ services
are available to all users free of charge. For more information see Data Handling on page 30.

Figure 61 - Data Visualization and Analysis



WSDA®-1500-LXRS®Wireless Sensor Data AggregatorUserManual Data Processing

80

7.1 WSDA® Data Downloader

The WSDA® Data Downloader is included with the Node Commander® Software Suite and
allows the user to download sensor data stored in the WSDA® - 1500 - LXRS® gateway
memory to a host computer. The data will be in CSV format. Only the sensor channels selected
will be downloaded into the CSV file. Data can also be erased from the gatewaymemory in this
menu.

Open the WSDA® Data Downloader by running it from the Windows® Start menu. Enter the
gateway IP address and log-in information. The IP address can be determined in Live
Connect™, and the log-in credentials are the same as for logging into the gateway Control
Panel (seeGatewayOverview on page 8).

The WSDA® Data Downloader has four main features; the ability to select and download
sensor data, apply calibration coefficients to the data prior to downloading (from the Control
Panel Calibration menu settings, see WSDA® Data Downloader Calibration Coefficients on
page 53), combine all downloaded data into one file, and clear the data from the gateway
memory (Figure 62 - WSDA® Data Downloader). How long it takes to download depends on
the amount of data selected.

Figure 62 - WSDA® Data Downloader
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8. Gateway Installation

8.1 Installation Recommendations

TheWSDA®-1500-LXRS® is rated for indoor use only, unless housed in a ruggedized outdoor
enclosure.  A ruggedized version of the WSDA ® - 1500-LXRS® is available from LORD
MicroStrain®. For more information see Parts and Configurations on page 96.

The gateway has twomounting tabswith holes for fastening (Figure 63 - Gateway Installation).
It can be mounted in any orientation, but it is recommended that it is mounted in a way that
optimizes the wireless communications, typically with the antenna pointing upward. For more
information seeOptimizing the Radio Link on page 82. 

Figure 63 - Gateway Installation
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8.2 Optimizing the Radio Link

In ideal conditions, the nodes and gateway can communicate up to two kilometers apart.  In
order to accomplish this, the node and gatewaymust be installed in amanner that optimizes the
wireless transmission.  The WSDA® - 1500- LXRS® operates at a 2.4GHz transmission
frequency and comes standard with a right-angle, ¼-wave rubber whip antenna with an omni-
directional radiation pattern.  The antenna has a joint in the middle that allows it to be rotated
and aimed. Using any other antenna than the one that is included with the node will void FCC
compliance.

The best method for ensuring optimal radio communication is to conduct an RF survey of the
installation site. This is easily accomplished in Node Commander® by using the range test
feature to quantify the radio signal strength (RSSI) in various scenarios. See Range Test on
page 83 for instructions on using Node Commander® for measuring RSSI. The following are
general guidelines for maximizing transmission range:

l Establish Line of Sight (LOS) between the node and gateway antennas as best
as possible.  Try to avoid obstructions between the antennas, such as buildings,
terrain, vegetation, or other physical barriers.  Increase the mounting height of the
node or antenna to allow a clearer LOS path to the gateway.  Height above the
ground is also important because reflections off of the ground can interfere at the
receiver. Generally, the higher above the ground the better.

l Minimize Radio Frequency Interference (RFI) such as other equipment
antennas, especially those operating in the same frequency range.  This includes
other nodes.  If other antennas are required nearby, mount them at different
heights to minimize interference. Additionally, the specific node frequency is
selectable within its operational range using the Node Commander® software. Set
the devices to different transmission frequencies.

l Minimize Electromagnetic Interference (EMI) such as that which is generated
by power transmission equipment, microwaves, power supplies, and other
electromagnetic sources.

l Metal Objects in close proximity to either antenna, particularly ferrous metals
such as steel and iron, can be problematic for wireless communications.  The
larger the object, the greater the influence. 
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8.2.1 Range Test

After establishing communication between node and gateway, use the range test feature in
Node Commander® to monitor the signal strength and to optimally position the nodes,
gateway, and antennas for installation. Maximum achievable range is determined by the
gateway and node power settings (found in the device Configure menu) and is highly
dependent on the physical environment surrounding the devices.

1. Right-click on the node header, and select Communicate > Range Test.

Figure 64 - Range Test Menu

2. The total RSSI range for the node and gateway is -90 to 0dBm. The higher
the value(closer to zero), the better, but reliable communication can be
achieved between - 75 dBm and 0 dBm. The devices is still able to
communicate between -90 dBm and -75 dBm, but it could be intermittent or
result in data loss. Position the node and gateway antennas where the best
RSSI value is observed.

Figure 65 - Range Test Statistics
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8.3 Multi-port Connector Interface

The WSDA®-1500-LXRS® multi-port connector is currently only used for CAN J1939 output
connections and customized RS232 options, such as for use with LORD MicroStrain® inertial
sensors. The remaining are used during manufacturing, or are reserved for future use. For
mating connector information and pre-made cable assemblies see Gateway Accessories on
page 96.

Pin
Number

Signal
Pin

Number
Signal

1 (future use) 14 (future use)
2 (reserved) 15 +5V
3 +5V 16 (future use)
4 (reserved) 17 Tx
5 GND 18 +5V
6 (future use) 19 Rx
7 (future use) 20 GND
8 (not used) 21 1 PPS Out
9 (future use) 22 1 PPS In
10 GND 23 CAN High
11 (future use) 24 CAN Low
12 (future use) 25 (future use)
13 +5V 26 (future use)

Table 11 - Multi-port Pin Designations
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8.4 Gateway Power Supply

Apply only the input voltage range specified for the gateway. 
Failure to do so could result in personal injury and permanent
damage to the gateway (see Safety Information on page
104).

Power required for the gateway to operate is applied through the gateway power supply
connector (Figure 66 - Gateway Power Supply).  The gateway starter kit includes a power
supply and AC outlet adapters for use in various countries. It is recommended this power
supply be used (or another regulated AC-to-DC power supply with the appropriate output
parameters, see Operating Specifications on page 101).  Observe connection polarities, or the
gatewaymay be damaged.

Figure 66 - Gateway Power Supply
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9. Troubleshooting

9.1 Troubleshooting Guide
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Problem Possible cause and recommended solution

1. POWER

gateway or node does
not turn on

1.1 node or gateway power is off

The status indicator LED on the device may be off.  Turn the
device on, and the status indicator LED should illuminate.

1.2 external power is off or miswired

Verify the device power source is connected correctly and
powered on.

1.3 wrong power supply

Using a power supply other than the one specified for the device
(or an external supply that is outside of the device operating
range) could result in permanent damage to the device or cause
it to not work properly.

1.4 node battery is dead

If the node will not power on, the node battery may need to be
replaced. Contact LORD MicroStrain® Technical Support (See
Technical Support on page 94).

1.6 node battery fault

If the battery charge indicator on the node is only dimly
illuminated when charging is attempted, a battery fault condition
has occurred. Unplug power, and then plug it back in. The
indicator should turn on brightly, indicating charging.

1.7 sensors are drawing too much current

The node battery can only supply a limited amount of power to
the connected sensors.  If an over-current condition occurs, the
node will shut down.  Consider powering the node or sensors
with an external source. 

1.58 node or gateway is damaged

If all power settings and connections have been verified, and the
node is still unresponsive, contact LORD MicroStrain ®

Technical Support (See Technical Support on page 94).

2.1 node or gateway has no power
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Problem Possible cause and recommended solution
2. COMMUNICATION

no communication to
the gateway or node

Verify the node and gateway have power applied and that
applicable power switches are on.  Power is indicated on both
devices by a status indicator LED.

2.2 gateway has no communication with the computer

Verify gateway communication in the software. Check, remove,
and reconnect communications and power cables as applicable. 

l For serial gateways, verify that the COMport setting.

l For USB gateways, verify that the drivers are installed on the
computer (included with Node Commander®) and that the
software has had sufficient time to detect it.

l For Ethernet gateways, use Live Connect™ to verify
communications on a DHCP network. Check that the
extended timeouts are enabled in the Node Commander®

Edit > Preferencesmenu, under Devices. Once
communication has been established, the network
configuration can be changed.

2.3 node cannot be configured

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling or sleeping, it cannot be configured. In Node
Commander®, execute the Stop Node command to put the
node in idle state, allowing configuration to occur.

If the user inactivity timeout is set very low, the configuration
menuwill have to be entered quickly, before the timeout occurs,
putting the node back in a sample or sleep state.

2.4 node is out of range

Perform a bench test with the node in close proximity to the
gateway to verify they are operational.  For range test and
installation recommendations see Range Test on page 83.  The
system has been tested to operate with the node and gateway
up to 2 km apart with clear line of sight.
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Problem Possible cause and recommended solution

2.5 node is not in normal boot mode

If the node status indicator shows the node booting in a mode
other than the normal boot mode, it can be bypassed by toggling
the node ON/OFF switch rapidly three times, then leaving it in
the ON position for normal power up. In normal boot mode the
communication can be established with automatic node
discovery (or manually) once the boot process is complete and
the node is in idle state. Start-up mode can then be changed in
the software.

2.6 node is sampling

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling, it cannot be configured. In Node Commander® ,
execute the Stop Node command to put the node in idle state,
allowing configuration to occur.

2.7 node is sleeping

Observe the node status indicator LED to determine what state
it is: boot, idle, sample, or sleep. If the node is sleeping, it cannot
be configured. In Node Commander®, execute the Stop Node
command to put the node in idle state, allowing configuration to
occur.

2.8 gateway or node is damaged

Verify all connections, power, and settings.  If available, try
installing alternate nodes and gateways one at a time to see if
the faulty device can be identified.  If no conclusion can be
determined or to send a device in for repair, contact LORD
MicroStrain® Technical Support (See Technical Support on
page 94).

3. DATA ACQUISITION

sensor data is missing
or incorrect

3.1 no communication to node or gateway

Verify connections and power to the node and gateway. Verify
they are powered on and communicating with the software.
Enter a configurationmenu to verify that the node can be
accessed.

3.2 sampling settings are incorrect
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Problem Possible cause and recommended solution

If the sampling mode, rate, or duration are not performing as
expected, enter the node configuration menu, and verify the
sampling settings.

3.3 sampling has not started

If sampling is occurring, the sampling mode will be displayed
next to the node name in Node Commander®. The node device
status indicator will also be flashing the sampling mode code. If
the node is not sampling, activate it in the software or with a
sample on start up boot sequence.

3.4 sensor channel not configured correctly

Verify that the sensor is configured on the correct channel and
has been enabled for data acquisition. 

3. sensor calibration is invalid

External sensors come with a factory calibration value that is
entered during configuration. Internal sensors are factory
calibrated and should not need adjustment. The calibration data
is provided with the sensor when purchased.If possible, perform
a field verification of the sensors by applying known loads and
comparing the measured values.  In the channel configuration
settings, verify that the calibration calculations are correct.  
Verify that the gain and offset range are correct and that the
baseline offset is set with Auto Balance, as applicable.   Verify
that the calibration values (slope and offset) are correct. Verify
that the sensor channel units are selected correctly.  Verify that
all parameters were written to the node channel. Recalibrate as
needed.
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9.2 Device Status Indicators

The following is a complete summary of theWSDA®-1500-LXRS® status indicators.

Indicator Behavior Node Status

POWER
OFF Gateway is off
ON green Gateway is on

CLOUD

OFF Gateway is off
Flashing blue Uploading data to SensorCloud™
ON green Web upload successful
ON red Web upload error or gateway is booting up

ACT -- (future use)

DATA

OFF Gateway is off or no data being received
Flashing green Receiving wireless data
Flashing blue Sync sampling beacon

Flashing red
Another gateway beacon
detected on the same frequency

ON green No data being received

WSDA

OFF Gateway is off
ON blue Initial power and boot-up
ON green Fully booted & idle

Flashing blue & green
Sampling and porting data through Node
Commander®

Flashing blue
User-prompted firmware upgrade in pro-
cess or in initial power and boot-up phase

ON red
In initial power and boot-up phase or
user-prompted firmware upgrade failed

Table 12 - Device Status Indicators
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9.3 Communications Ports in Windows®

Serial gateways (including USB gateways) have either a standard serial or virtual
communications port inWindows®. Windows®DeviceManage can be used to determine what
communication port the gateway is connected to.

1. Click on theWindows® Start icon, and select Control Panel.

2. Navigate to the System menu, and select Device Manger. The menus may appear
different depending on the version ofWindows and the View settings.

Figure 67 -Windows® System Menu
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3. In DeviceManager, expand the view for Ports (COMand LPT). Active COMports will
appear on this list with the COM port number. A USB gateway will be displayed as
USB to UART Bridge (COM X ). A serial gateway will be attached to the
Communications Port (COMX). An Ethernet gateway will be connected to a Virtual
Serial port (COMX). If no port is listed, the port is not recognized by the computer, and
no gateway communication can be established.

Figure 68 - Windows® Device Manger Menu
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9.4 Technical Support

There are many resources for product support found on the LORD MicroStrain® website,
including technical notes, FAQs, and product manuals.

http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support

sensing_support@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

SKYPE:microstrain.wireless.support

Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_support@LORD.com
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10. Maintenance

There are no user-serviceable parts on the WSDA®-1500-LXRS®. For device service and repair
contact LORD MicroStrain® Technical Support (see Technical Support on page 94). Opening the
device will void the product warranty.
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11. Parts and Configurations

11.1 Standard Models

For the most current standard, custom, and OEM product options, refer to the LORD
MicroStrain®website or contact the LORD MicroStrain® SalesDepartment.

Model Number Description
LORD

MicroStrain®

Part Number
WSDA-1500-SK Ethernet Data GatewayStarter Kit 6314-1500

Configuration Options (specify at time of order)

l LORD MicroStrain® inertial sensor capable: a different operating system is
installed on the gateway to enable this feature, and to addGPS as an option in the
time synchronizationmenu.

11.2 Gateway Accessories

Description
LORD MicroStrain®

Part Number
Rugged outdoor enclosure with wired connector ports call for information

Power supply for WSDA®-1500-LXRS® 9011-0032
Power supply plug adapter kit 9011-0022

Standard whip antenna (FCC compliant) 9010-0049
Multi-port cable with flying leads call for information

Multi-port cable with CAN bus connector call for information
Multi-port cable with inertial sensor connector call for information

Ethernet cable (10 feet long) 9022-0025

Table 13 - Gateway Accessories

Description Manufacturer Part Number
26 pin male AMPLIMITE connector

TE Connectivity
5749621-2

connecter shell 749608-2
insertion tool 58430-1

Table 14 - Multi-port Mating Connector
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11.3 Recommended Sensors

Many sensors can be used with the WSDA® - 1500-LXRS® . The following are sensors
manufactured by LORD MicroStrain® and are supported for use with theWSDA®-1500-
LXRS®.   For help with other sensor applications contact Technical Support (see Technical
Support on page 94).

Model Description
LORD MicroStrain®

Part Number
3DM-GX3-15 Inertial Measurement Unit 6227-xxxx (various)
3DM-GX3-25 Attitude Heading and Reference System 6223-xxxx (various)
3DM-GX3-35 Attitude Heading and Reference System 6225-xxxx (various)
3DM-GX3-45 GPS Aided Inertial Navigation System 6228-xxxx (various)

Table 15 - LORD MicroStrain® Sensors



WSDA®-1500-LXRS®Wireless Sensor Data AggregatorUserManual Parts and Configurations

98

11.4 Wireless System Equipment

Model Description
LORD

MicroStrain®

Part Number
-- Node Commander® Software 6301-0300

--
SensorCloud™ Software Subscription
(contact LORD MicroStrain® Sales)

--

WSDA-BASE-104 USB Gateway 6307-1040
WSDA-BASE-102 RS232 Serial Output Gateway 6307-1020
WSDA-BASE-101 AnalogOutput Gateway 6307-1010
G-Link-LXRS Wireless Accelerometer Node various models
G-Link2-LXRS Wireless Accelerometer Node various models
SG-Link-LXRS Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-OEM Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-RGD RuggedizedWireless Analog Sensor Input Node various models
V-Link-LXRS Wireless 7-Channel Analog Input Sensor Node various models
TC-Link-LXRS Wireless Thermocouple Node various models
DVRT-Link-LXRS WirelessDisplacement Sensor Node various models
ENV-Link-Pro Wireless Environmental Sensor Node various models
Watt-Link-LXRS Wireless EnergyMonitoring Sensor Node various models
RTD-Link-LXRS WirelessRTD Sensor Node various models
IEPE-Link -LXRS Wireless IEPE Accelerometer Node various models

Table 16 -Wireless System Equipment
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11.5 Product Ordering

Products can be ordered directly from the LORD MicroStrain® website by navigating to the
product page and using the Buy feature. 

http://www.microstrain.com/wireless

For further assistance, our sales team is available to help with product selection, ordering
options, and questions.

Sales Support

sensing_sales@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_sales@LORD.com
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12. Specifications

12.1 Physical Specification

Dimensions: 147mmx 110mmx 23mmwithout antenna
Weight: 346 gramswith antenna

Enclosure Environmental Rating: General purpose indoor
(IP67/NEMA4X rated enclosure available)
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12.2 Operating Specifications

Parameter Specifications
General

Processor ARM® Cortex™ A8, 1 GHz

Operating system Linux

Connectivity
Ethernet IEEE 802.3 10/100Mbps, IEEE 802.15.4 wireless,
J1939 CAN (output only)

Internet standards HTTP, HTTPS,TCP/IP, UPnP

IP assignment IPV4 Static or DHCP

Data storage memory 4G bytes Micro SD (optional upgrade to 8GB or 16GB)

Time synchronization
Network time protocol (NTP), Real time clock (RTC), last used,
manual entry

CAN J1939 Output

J1939 Bit Rate 250 K bps, 500 K bps, 1M bps

J1939 Source Static or dynamic via SAEName

J1939 Destination Static or SAEName

J1939 Modes
Tunnel data to destination using PGN 0xEF00, or broadcast
data values using PGNs 0xFF00 – 0xFFFF

Standard bus termination 120Ω
Sampling

Supported node sampling
modes

Synchronized, low duty cycle, continuous, periodic burst,
event-triggered, and datalogging

Synchronization beacon
interval

1 Hz beacon provides ± 32 μsec node-to-node synchronization

Synchronization beacon
stability

±3 ppm

Network capacity

Up to 2000 nodes per RF channel (and per gateway) depending
on the number of active channels and sampling settings.
Refer to the system bandwidth calculator:
http://www.microstrain.com/configure-your-system

Operating Parameters

Wireless communication range
Outdoor/line-of-sight: 2 km( ideal)*, 800m (typical)**
Indoor/obstructions: 50m (typical)**

Radio frequency (RF)
transceiver carrier

2.405 to 2.470GHz direct sequence spread spectrum over 14
channels, license-free worldwide, radiated power
programmable from 0 dBm (1mW) to 16 dBm (39mW); (low
power option available for use outside the U.S.A.- limited to 10
dBm (10mW)

RF communication protocol IEEE 802.15.4

Power consumption 2900mW (max), 2300mW (typ)@12 V dc

Operating temperature -40 °C to +85 °C

MTBF 408,000 hours (Telcordia method, SR332)

Physical Specifications

Dimensions 147mm x 110mm x 23mm without antenna

Weight 346 grams

Enclosure material Black anodized aluminum

Integration

Connectors RJ45 jack, 26 pinmulti-port, 2.1mm power jack

Communications cable Ethernet (CAT6 cable included in starter kit)

Compatible sensor nodes All LXRS® sensor nodes, all legacy 2.4 GHz nodes

Firmware Firmware andOS upgradeable through web interface

Software
SensorCloud™,SensorConnect™, Node Commander®,
WSDA® Data Downloader, Live Connect™, Windows
XP/Vista/7 compatible

http://www.microstrain.com/configure-your-system
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Parameter Specifications

Software development kit (SDK)
Data communications protocol available with EEPROMmaps
and sample code (OS and computing platform independent)
http://www.microstrain.com/wireless/sdk

Regulatory compliance FCC (U.S.), IC (Canada), CE, ROHS

*Measured with antennas elevated, no obstructions, and no RF interferers.
**Actual range varies depending on conditions such as obstructions, RF interference, antenna height, & antenna orientation.

http://www.microstrain.com/wireless/sdk
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12.3 Radio Specifications

The WSDA® - 1500-LXRS® Wireless Sensor Data Aggregator employs a 2.4GHz IEEE
802.15.4 compliant radio transceiver for wireless communication.  The radio is a direct-
sequence spread spectrum radio and can be configured to operate on 14 separate frequencies
ranging from 2.405GHz to 2.470GHz. Following the 802.15.4 standard, these frequencies are
aliased as channels 11 through 24.  For all newly manufactured nodes, the default setting is
2.425GHz (channel 15). 

For standardmodels, radiated transmit power is programmable from 0 dBm (1 mW) to 16 dBm
(39 mW).  A low-transmit power option is available (for use in Europe and elsewhere) and is
limited to 10 dBm (10mW).

The radio complies with FCC Part 15 (USA) and IC (Canada) regulations. The radio is license-
free worldwide.  Using antennas and transmission equipment other than what is providedmay
void FCC compliance.
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13. Safety Information

This section provides a summary of general safety precautions that must be understood and
applied during operation and maintenance of components in the LORD MicroStrain® Wireless
Sensor Network. Throughout the manual, ANSI Z535 standard safety symbols are used to
indicate a process or component that requires cautionarymeasures.

13.1 Power Supply

The WSDA®-1500-LXRS®Wireless Sensor Data Aggregator is powered by an external AC
power supply.

Apply only the input voltage and frequency range specified
for the WSDA®-1500-LXRS®.  Connect to a power source
that is near the device, is accessible, and adheres to all
national wiring standards. Compliance with wiring standards
is assumed in the installation of the power source and
includes protection against excessive currents, short
circuits, and ground faults. Failure to do so could result in
personal injury and permanent damage to the device.  For
details on how to connect the power supplysee Gateway
Power Supply on page 85.

13.2 ESD Sensitivity

The WSDA®-1500-LXRS® is susceptible to damage and/or disruption of normal operation
fromElectrostatic Discharge (ESD), particularly during data acquisition.

ESD damage can occur when the device is touched,
especially at the device interfaces such as the antenna and
connectors. Use proper grounding techniques when
handling. If an ESD event occurs, and operation has been
interrupted, reset the device by cycling power to it and/or
restarting the operational mode in the system software.
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13.3 Disposal and Recycling

The WSDA®- 1500-LXRS® contains internal batteries,
printed circuit boards, and electronic components. These
items are known to contain toxic chemicals and heavy
metals that are harmful to humans health and the
environment.  Disposal is subject to federal and local
laws. Do not discard the device or batteries in the trash. 
Follow proper electronic and battery waste disposal
protocol, as dictated by federal and local authorities.
Some states also have programs for extracting reusable
parts for recycling.
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14. References

14.1 Reference Information

Many references are available on the LORD MicroStrain® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated,
and new applications are added. They may provide more accurate information than printed or
file copies. 

Document Where to find it

Online Wireless Network Calculator
http://www.microstrain.com/configure-your-

system
SensorCloud™
Overview

http://www.sensorcloud.com/system-
overview

MathEngine® Overview http://www.sensorcloud.com/mathengine
LORD MicroStrain®Wireless Sensors
Network Software Development Kit

http://www.microstrain.com/wireless/sdk

Product Datasheets http://www.microstrain.com/wireless/sensors
Product Manuals and Technical Notes http://www.microstrain.com/support/docs

Product Application Notes http://www.microstrain.com/applications
SAE CAN J1939 Protocol http://store.sae.org/j1939/contents/
NIST Calibration Procedures http://www.nist.gov/calibrations/

ASTM Testing Procedures
http://www.astm.org/Standard/standards-

and-publications.html

Table 17 - Related Documents

http://sensorcloud.com/pricing?showCalculator=true
http://sensorcloud.com/pricing?showCalculator=true
http://www.sensorcloud.com/system-overview
http://www.sensorcloud.com/system-overview
http://www.sensorcloud.com/mathengine
http://www.microstrain.com/wireless/sdk
http://www.microstrain.com/wireless/sensors
http://www.microstrain.com/support/docs
http://www.microstrain.com/applications
http://store.sae.org/j1939/contents/
http://www.nist.gov/calibrations/
http://www.astm.org/Standard/standards-and-publications.html
http://www.astm.org/Standard/standards-and-publications.html
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14.2 Glossary

These terms are in common use throughout themanual:

A/D Value: the digital representation of the analog voltages in an analog- to- digital (A/D)
conversion. The accuracy of the conversion is dependent on the resolution of the system
electronics; higher resolution produces amore accurate conversion. Also referred to as "bits".

Base Station: The base station is the transceiver that attaches to the host computer and
provides communication between the software and the node(s). It is also referred to as a
“gateway”.

Burst Sampling: amode of operation in which the node is sampled for a fixed window of time
(burst), and then repeats that window at set intervals. The burst duration and time between
bursts is configurable. Same as periodic burst sampling.

Calibration: to standardize a measurement by determining the deviation standard and
applying a correction (or calibration) factor

Configuration: a general term applied to the node indicating how it is set up for data
acquisition.  It includes settings such as sampling mode and rate, number of active channels,
channel measurement settings, offsets, hardware gain, and calibration values. 

Continuous Sampling: a mode of operation in which the node is sampled continuously until
stopped, or continuously for a fixed amount of time.

Coordinated Universal Time (UTC): the primary time standard for world clocks and time. It
is similar to GreenwichMean Time (GMT).

Cycle Power: a command transmitted to the node to reboot it, either through a hardware or
software switch

Data Acquisition: the process of collecting data from sensors and other devices

Data Logging: the process of saving acquired data to the system memory, either locally on
the node or remotely on the host computer

DHCP (network): Dynamic Host Configuration Protocol is the standardized networking
protocol used on Internet Protocol (IP) networks, which automatically configures devices that
are attached to it by assigning and configuring the device IP address.
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EMI: Electromagnetic Interference is an inductive or radiated disturbance that can create
signal degradation on electrical signals, including loss of data.

ESD: Electrostatic Discharge is the sudden flow of electricity that can occur between two
charged objects of different potential that come in contact or in close proximity of each other.
Static electricity is a common source of ESD.

Event-Based Sampling: a mode of operation in which the node sampling is started when a
sensor measurement value (threshold) is achieved.

Firmware: the code that is programmed onto a microcontroller or similar device in an
embedded system. It includes device operation commands, conditions, memory allocation, and
many other tasks. 

Gateway: The gateway is a transceiver that attaches to the host computer and provides
communication between the software and the node(s). It is also known as a “base station”.

Host (computer): The host computer is the computer that orchestrates command and control
of the attached devices or networks.

LED: Light Emitting Diode is an indicator light that is used in electronic equipment.

LOS (Line of Sight): is used in radio communications to describe the ideal condition between
transmitting and receiving antennas in a radio network. As stated, it means the antennas are in
view of each other with no obstructions.

LXRS®:Lossless Extended Range Synchronized is the proprietary LORD MicroStrain® data
communications protocol used in the wireless sensor network.

Node: The node is the wireless transceiver that the sensor (s) is connected to, providing
communication with the gateway.  The G-Link® -LXRS®, V-Link® -LXRS®, and SG-Link® -
LXRS® are examples of nodesmanufactured by LORD MicroStrain®.

Node Tester board: TheNode Tester board is a device designed by LORD MicroStrain® that
can be plugged into nodes to test their functionality.

Offset: When describing amathematically-linear relationship, the offset is the value where the
line that represents the relationship in a graph crosses the y-axis.  The equation of a straight
line is: y = mx+b, where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope and
b is the offset.



WSDA®-1500-LXRS®Wireless Sensor Data AggregatorUserManual References

109

Oversampling: In signal processing, oversampling is a technique used to achieve increased
signal resolution and better noise immunity by recording readings at a higher frequency than
the output of the device being measured. In analog- to- digital conversion, the higher the
oversampling rate, the better the recreated analog signal.

Packet: unit of sampled data

Periodic Burst Sampling: a mode of operation in which the node is sampled for a fixed
window of time (burst), and then repeats that window at set intervals. The burst duration and
time between bursts is configurable. Same as burst sampling.

Ping: a byte transmitted by the gateway to the node. The node responds by echoing the byte,
indicating communication exists between the node and gateway.

Range Test: a continuous string of pings used to validate communication between the
gateway and the node over distance and obstruction

Real Time Clock (RTC): a computer clock that keeps track of the current time

RFI: Radio Frequency Interference is a disturbance in an electrical circuit due to
electromagnetic induction or radiation.

RSSI: Received Signal Strength Indication is a measurement of the transmission power in a
radio signal. It ismeasured in decibels with reference to 1milliWatt (dBm).

RS232: a serial data communications protocol

Sensor: a device that physically or chemically reacts to environmental forces and conditions,
producing a predictable electrical signal

Sleep: a command transmitted to the node to put it into sleep configuration

Sampling: the process of takingmeasurements from a sensor or device

Sampling Mode: the type of sampling that is being utilized, such as event- triggered,
continuous, or periodic. The nodes have several samplingmodes that employ these types of
sampling.

Sampling Rate: the frequency of sampling
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Slope:When describing amathematically linear relationship, the slope is the steepness of the
line that represents that relationship on a graph.  The equation of a straight line is: y = mx+b,
where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope, and b is the offset.

Streaming: Streaming is a sampling mode in which all active channels (and the sensors
attached to them) are measured, and the acquired data is transmitted to the gateway and
software. The data is not written to non- volatile memory during streaming.  Streaming can
either be finite (have a user defined start and end time) or continuous (continued until the power
is cycled on the node).

Synchronized Sampling: a sampling mode that automatically coordinates all incoming node
data to a particular gateway. Thismode is designed to ensure data arrival and sequence.

Transmission rate: the number of data packets per transmission window, measured in
seconds. Depending on the samplingmode and settings it will be between 1 and 64
packets/second.

Transmission window: the time allowed for one data transmission at the automatically
determined transmission rate

USB:Universal Serial Bus, a serial data communications protocol

WSN: Wireless Sensor Network describes a distribution of sensors and data acquisition
equipment that autonomously monitors environmental characteristics, such as temperature,
pressure, and strain.
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